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1 INTRODUCTION 

The Tactical Display Framework (TDF) is an adaptable, graphical, object-oriented 
Command and Control (C2) system capable of supporting the growing needs of the tactical user. 
To promote portability and reusability, all software is written in the Java programming language. 
In fact, TDF has been certified by Sun Microsystems  as ‘100% Pure Java.’ Although TDF can 
execute in standalone mode, it is typically connected to an information source via a socket 
connection or a Common Object Request Broker Architecture (CORBA)-compliant interface.  

Solipsys released TDF Version 3.4 on January 9, 2002 as an upgrade to the previous 4 
series releases. TDF 3.4 now includes an intelligent doctrine application for alerts and 
automation. The Doctrine application is a solution to automated alerts. Doctrine intelligently 
processes user-configurable settings to produce reliable results that can be based on track 
behaviors. A new Marker List application incorporates proven techniques to enable improved 
user-interaction. Details and Tags Editors have been replaced by a unified Details Editor that 
provides greater capacity to display information on the main display. Performance has taken 
another leap forward. Among other system additions, TDF now support a sophisticated dynamic 
memory allocation system, which has drastically reduced sensor memory requirements. 

TDF Version 3.4’s peak performance is achieved using Java Developer’s Kit Version 1.3 
(JDK 1.3.1) under Windows NT 4.0/2000 although it will function in JDK 1.2 and Version 1.1 of 
the Java Foundation Classes (JFC 1.1 and Swing 1.1.1). Since TDF is implemented in Java, its 
portability is outstanding: TDF will run without modification on any machine that supports the 
Java Virtual Machine (JVM). To date, TDF has been hosted successfully on a variety of Intel 
machines running Windows95/98/NT/2000 and Sun, HP, DEC, IBM, and SGI platforms running 
UNIX variants. Minimum PC requirements for Windows 98/2000/NT 4.0 machines and UNIX 
boxes are as follows: 

PC Minimum Requirements UNIX Minimum Requirements 
Pentium III 450 MHz 
256 MB RAM 
32 MB Graphics Card 
2 GB free hard disk space 

Java 2 Platform (Solaris 7.0, IRIX 6.5, 
HP/UX 10.0 etc.) 
256 MB RAM 
2 GB free hard disk space 

Preferred Minimum Requirements Preferred Minimum Requirements 
Windows NT 4.0/Windows 2000 
Pentium III 800 MHz (JDK 1.3)  
256 MB RAM  
32 MB video card 
2 GB free hard disk space 

Latest Operating System (with Native   
Thread Support) 
256 MB RAM  
2 GB free hard disk space 
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2 JUMP-START BASICS 

2.1 TDF Display  

The first step to understanding TDF is to familiarize oneself with its major components. 
The top-level window is divided into three main areas (Figure 1): 

• The menu bar, at the top, lists the available applications.  
• The main display, in the middle, displays user-selectable vehicular dynamic symbols 

overlaid on high-resolution, digitized map products. 
• The control bar along the bottom provides quick access to a variety of mini-displays and 

commands. 
 

 
Figure 1. TDF Main Display 

This document may use terminology that differs from what an operator normally uses. 
One example of this is TDF’s main display. In fact, the main display was referred to as the 
TACSIT in the most recent release of TDF. The US or an international armed force may use the 
equivalent terms, such as SiD (Situation Display), Common Operational Picture (COP), or 
Common Tactical Picture (CTP). The main display and other perhaps unfamiliar terms will be 
defined and used throughout this document and any newly generated documentation.  

Additionally, some screen examples in this document may look different from a user’s 
screen. The look and feel can be radically changed to other styles in the Preferences 
(System>>Preferences) application. Since TDF is so flexible and reconfigurable, the 
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configurations used in this document may vary from the user’s build. If a user would like to 
extend TDF’s capability, please contact Solipsys Corporation for more information.  

The other portions of TDF can be toggled on and off easily to use the main display in full 
screen. Table 1 lists these options and other keyboard shortcuts.  

Table 1. Keyboard Shortcuts 

 
Keyboard Shortcuts Action 
 F1 Help Viewer 
 F2 Reset Pointer Control 
 F4 Toggle Control Bar Display 
 F5 Toggle Menu bar Display 

2.2 Using System Features 

Table 2contains a list of commands and applications found under the System menu. Most 
of the following commands affect TDF globally. 

Table 2. System Features 

 
Command Action 
Open Opens saved files that contain certain settings, but the 

save/open does not restore/persist certain applications, 
such as view location and markers 

Save Saves the current settings of the main display 
Collaborate Control Panel for Net Meeting 
Preferences Allows users to configure animation detail, appearance, 

bearings, network distribution, and pointer options. 
Print Lists and enables printing of various views  
Status Displays system status 
Reset Clears all sensor and track information in database and 

resets selected applications to default 
Close all Closes all applications except for the Main Display 
Quit Closes all applications and exits 
Unique Battle Lab 
Command 

Action 

Import Imports Air Tasking Order (ATO) databases into system 
MSCT Control Enables user-specified, identity-based data control, 

current configuration information, user-specified geo 
boundaries, and lists high priority tracks and interfaces 



 
  11 

2.3 Getting Around the Main Display 

2.3.1 Brightness Slider 

A user can drag the slider to the right to darken the background but does not darken the 
tracks. The tracks are highlighted by the contrast with the background.  

 
Figure 2. Brightness Slider  

2.3.2 Range Scale 

After a user knows the component parts of the TDF Display, understanding the various 
methods of map navigation is the next step.  

Changing the range:  

1. Select a tick mark on the icon (Figure 3).  
Or 

2. Drag the eye icon right (zooms out) or left (zooms in) to the desired range scale. 

 
Figure 3. Range Scale 

2.3.3 Using Pointer Mode 

Centering the main display on a selected position:  

Double-left click (<Ctrl> + left-click) on the main display to recenter it. 

Zooming in and out of an area:   

1. Double left-click (<Ctrl> + left-click) at a desired screen center position. 
2. Drag outward to increase its size and inward to reduce it; the main display will zoom in 

on the defined area. 
3. The click and drag stroke (click + hold + drag) will be mentioned frequently in this 

document.  

The rubberbanding stroke (a type of click and drag stroke) allows a user to zoom in or out 
on a particular section of the earth by expanding or shrinking a yellow rectangle. This 
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rubberbanding also displays a range value for the rectangle. This stroke can only be 
accomplished with the pointer (Figure 4).  

 
Figure 4. Arrow Pointer (default) 

2.3.4 Using Pan Mode 

Panning across an area:  

Double left-click (<Ctrl> + left-click) on the main display and drag the mouse in a 
desired direction.  

Zooming in and out of an area:   

Middle double-click (<Ctrl> + <Alt> + left-click) on the main display and drag the 
pointer up to zoom in or drag it down to zoom out. 

 
Figure 5. Pan Icon 

2.3.5 Using Drag Mode 

Moving around the position on the screen:  

Double left-click the cursor, the screen will move in the direction of the mouse. 

Zooming in and out of an area:  

Double left-click (or Hold <Ctrl> + <Alt>) left-click and drag up to zoom in and down to 
zoom out. The screen center position does not change when the zoom feature is used in 
the drag mode. 

 
Figure 6. Drag Icon 

Manipulating the main display using the keyboard: 

A list of default, navigation commands appears in Table 3. 
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Table 3. Navigation Commands 

 
Left Arrow or J West 
Right Arrow or L East 
Up Arrow or I North 
Down Arrow or K South 
+ Zoom In 
- Zoom Out 

 

2.4 Hooking Tracks 

TDF supports multiple hooks, primary (encircled) and secondary (ensquared). In both 
groups, one object is considered the active hook and is prominently highlighted (Figure 7). All 
known information of the actively hooked track is displayed in details windows located in the 
upper corners of the main display. 

Hooking primary tracks: 

1. To hook one track: Left-click on the track. 
2. To hook multiple tracks: <Shift> + left-click and drag. A green box will enclose all 

hooked tracks; tracks are hooked upon the release of the mouse button. 
3. To unhook a track: Left-click to unhook all primary tracks. 
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Figure 7. TDF Hooked Tracks 

Hooking secondary tracks:  

• To hook one secondary track: Middle-click (<Alt> + left-click) on the track. 
• To hook multiple secondary tracks: <Shift>, middle-click, and drag (<Alt> + <Shift> + 

left-click and drag).  
• To unhook secondary tracks: Middle-click (<Alt> + left-click) on map not object. 

 

Table 4. Hook Reference 

 
Single Hook (Selection) 

Mouse Operations Action 
Left-click Primary Hook 
Left-click elsewhere on display Unhook Primary 
Middle-click or <Alt> + left-click  Secondary Hook 
Middle-click or <ALT> + left-click elsewhere on display Unhook Secondary 

Group Hook (Multiple Selections) 
Mouse Operations Action 
<Shift>  + left-click + Drag Primary Group Hook 
Left-click elsewhere on display Unhook Primary Group 
<Shift>  + middle-click or <Alt> + <Shift> + left-click  Secondary Group Hook 
Middle-click or <ALT> + left-click elsewhere on display Unhook Secondary Group 
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Tracks can also be hooked using the Hook Application: <Ctrl>+K, the Control Bar, and 
Menu Bar (Tracks>>Hook) all provide the Hook Application. Figure 8 illustrates the hook 
application found in the Control Bar.  

Using the Hook application: 

• Choose a category, such as CALLSIGN, Display Track Number (DTN), Joint Track 
Number (JTN), Cooperating Unit (CU), Identify Friend or Foe (IFF), to specify a hook.  

• Insert information appropriate to the category into the text field.  
• Use a single asterisk (*) by itself to hook all objects contained within a certain condition, 

such as all tracks with a CALLSIGN.  

 
Figure 8. Hook Application 

2.5 Details 

Details and tags are pop-up windows containing configurable information that appear on 
the main display. As shown in Figure 9, details can appear when a track is selected or rolled 
over. If multiple tracks are primary hooked, a detail window will darken and two arrows and a 
menu icon will appear in the window. Using either the Page Up or Page Down keyboard buttons 
for primary hooks (Shift + Page Up or Page Down for secondary hooks) or the small arrows in 
the Details windows allows the operator to scroll through the list. The menu icon gives a list of 
hooked objects, so the user can jump to the wanted track without cycling through all the hooked 
tracks. When the pointer rolls over a track, a pop-up window appears in the lower left portion of 
the main display. This is called rollover. When a track is hooked, the windows appear in the 
upper-left (Primary hook) and upper-right (Secondary hook) of the main display. This is a superb 
way of gaining track information without cluttering the display.  

Tags are windows that appear near the track or marker. Once the tags are configured, 
they can be cycled with use of the Tags button in the upper control bar. To configure details and 
tags, use the Details Editor (Features>>Details) in the main menu bar and follow directions in 
the Details Editor section of this document.  

 

 



 
  16 

 
Figure 9. Details Windows 

2.6 Action Menus 

Action menus are pop-up menus that appear when user right-clicks on the main display. 
Some options are shortcuts but many toggle different capabilities, such as the Details window, on 
and off. The content of these pop-up menus will change according to a user’s particular 
configuration and the context in which the pop-up menu appears. There are action menus for 
many different contexts, such as main display, tracks, markers, pairing lines, and engagement 
lines. The two main menu contexts are main display and track. 

2.6.1 Main Display Menu 

The Main Display pop-up menu (Figure 10) substantially increases the capability of TDF. 
Navigations can be made at this level quickly and efficiently. This menu appears when a user 
right-clicks on the main display's map. 
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Figure 10. Main Display Menu 

The options included in the pop-up menu will vary according to the TDF configuration. 
Table 5 contains options usually included: 

 

Table 5. Action Menus 

 
Lat/Lon Centers on a specific location 
Own Track Centers on a user’s position 

Center On 

Track Centers on a variety of track numbers and call signs 
Next/Previous 
Primary 

Cycles through primary hooked objects one at a 
time and displays information known about the 
most highlighted in the Details window.  

Next/Previous 
Secondary 

Cycles through secondary hooked objects one at 
a time and displays information known about the 
most highlighted in the Details window. 

Primary A Details window appears whenever an object is 
primary selected.  

Rollover A Details window appears on rollover. 

Details 

Secondary A Details window appears whenever an object is 
secondary selected. 
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Tag On 
Selection 

Tags appear near track when a track is selected.  

Display 
Rollover At 
Object 

Details window appears near the object on rollover. 

On/Off Turns history on and off globally. History 
Selected Shows history only when an object is selected. 

Range 
In/Range 
Out 

Zooms the chosen display in and out. 

Range To Zooms to a given distance from the earth 
Ownship Tracks a user’s position (ownship) to keep the object 

in the center of the display. 
Primary Tracks the actively hooked object to keep the object 

in the center of the display. 
Secondary Tracks the actively hooked object to keep the object 

in the center of the display. 
Course Tracks the chosen object and keeps the direction of 

the earth in its course. 

Slave To 

Range Tracks and Zooms to maintain all selected objects in 
view, especially useful when more than one object is 
selected. 

Disable 
History 

Globally disables history no matter what other selections have 
been made. 

Disable 
Tags 

Globally disables tags regardless of other selections. 

2.6.2 Track Menu 

The track menu (Table 6) is a pop-up menu that appears when a user right-clicks on a 
track. It operates the same way as the above menu, but it affects only the track(s) selected. The 
actions selected from the pop-up menu are context sensitive to the group selections. The 
following table contains options usually included: 

Table 6. Track Menu 

 
Pending A track not yet subjected to the identification 

process. 
Unknown An evaluated track not yet identified although it 

has been through the identification process. 
Assumed 
Friend 

A Track is assumed friendly because of its 
Characteristics, Behavior, or Origin 

Assign ID 

Friend A Track belonging to a declared, friendly nation 
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Neutral A track whose Characteristics, Behavior, Origin, 
or Nationality indicates that it is neither supporting 
nor opposing friendly forces. 

Suspect A potentially dangerous track because of its 
Characteristics, Behavior, Origin, or Nationality 

 

Hostile A track eligible for engagement 
Call Sign Enables the editing of the selected object. 
Check In Time of last check in. 
Set Reference Establishes the selected object as a reference to the pointer. The 

selected object’s Bearing/Range is displayed near the pointer. 
Slave To Group Slaves the display to follow the group of 

hooked objects to keep all or most of the 
group onscreen at all times. 

 Track Number of 
Selected Object 

Tracks the selected object to keep it in the 
center of the display. 

 Course Tracks the chosen object and keeps the 
direction of the earth in its course. 

 Range Tracks and Zooms to maintain all selected 
objects in view, especially useful when more 
than one object is selected. 

Toggle 
History 

Toggles history on and off 

Toggle Tags Toggles tags on and off 
Add WEZ Toggles Weapons Engagement Zone, an overlay that appears in 

front of a track 
Force Tell Forces the selected object to be displayed regardless of filters 
High Priority Designates particular tracks and increases update rate 
Drop Track Kills track 

2.7 Preset Positions 

The Preset Positions application (Figure 11) enables the user to store and retrieve current 
screen center positions and range scales for later retrieval. 

Setting a preset position: 

1. Press and release 0 (zero), the default key used to toggle (display/dismiss) the view eye 
positions window. The view eye positions pop-up window should now be visible. 

2. Depress and hold a <number> key (1-9) until the position in the window is filled in.  By 
default, nine positions can be stored by using the keys 1-9.  

3. Left-click on the preset positions and drag to move it. 
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Retrieving a preset position:  

Press and release the appropriate number key. The preset screen center position and range 
scale will be restored in the main display. 

 
Figure 11. Preset Positions 

2.8 Dynamic Coordinates 

The Dynamic Coordinates (Figure 12) area provides a continuous readout of the current 
mouse pointer position whenever the pointer is placed inside the main display. All of these 
values are output in latitude and longitude. It also includes the current screen center coordinates, 
the current reference position, and the current ownship position. The following is a list of 
functions for the dynamic coordinates found in the control bar (from left to right): 

• Pointer position shows the location of the pointer. 
• The ownship pushbutton quickly centers the main display on ownship.  
• The ownship coordinates display position of ownship. 
• The locator pushbutton opens the view locator application. 
• The locator coordinates display either ownship or the locator’s center position.  
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Figure 12. Dynamic Coordinates 

There are several coordinate systems to choose from, including: Latitude and Longitude 
(LL); Local MGRS (Local); Universal Transverse Mercator (UTM); and Military Grid Reference 
System (MGRS). The Local MGRS is a truncated version of MGRS: it only displays the first 
two numbers of each number set. Unlike LL, Local, and UTM, the MGRS coordinate system 
does not have a reference point. 

Switching between Pointer coordinate systems: 

1. Right-click on the pointer coordinates  
2. Choose one of the systems 

Changing Ownship or Reference coordinate systems:  

1. Right-click on the reference coordinates  
2. Choose one of the systems 

A user can change the systems through the coordinate system panel in the Preferences 
application. Selections made in the control bar are independent of Preferences unless default is 
chosen. The default option refers to choices made in Preferences >> Coordinate Systems.  

Using the history option: 

1. Right-click on geographic locator’s center position coordinates 
2. Choose History  
3. Select recent location from menu. Any location coordinates in the menu following the 

one selected will be replaced by new location coordinates. Ten locations will remain in 
the buffer. 

This shortcut enables a user to jump to any preset location on earth. The View Locator 
Screen (Figure 13) is accessible through the menu bar (Help>>View Locator) and control bar 
(above). 
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Using Geographic Location Shortcut: 

Double left-click on the location entry or highlight the location and press the ‘Go To’ 
button. 

Saving a new location:  

1. Press ‘Add’.  
2. Enter name and lat/lon.  
3. Use the pointer in tandem with this application to find the lat/lon of any place on earth.  

 

 
Figure 13. View Locator 

2.9 Overlays 

The Overlay shapes found in the control bar permit quick overlay implementation. 
Overlays can be used as boundary zones, doctrine areas, ops areas, and free zones. 

 
Figure 14. Overlay Shapes 

Creating a new overlay: 

1. Depress Overlay pushbutton in the control bar and a slide menu will appear. 
2. Choose a shape in the menu while still depressing the pushbutton. 
3. Left-click in the main display to place the overlay. 
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Changing the size and shape:  

1. Left-click inside the shape to turn on edit mode.  
2. Drag the outer control points of the overlay to resize or reshape 

Moving the overlay:  

1. Left-click inside the shape to turn on the edit mode. 
2. Left-click on the center control point of the overlay. 
3. Drag to the desired position. 

When using the control bar to place overlays, a user may also want to take advantage of 
the overlay pop-up menu by right-clicking inside of overlay. This menu offers many editing 
options. When greater capability is needed, an operator should use the full Overlays application 
found in the menu bar (Features >> Overlays) to create, save, and display overlays. 

Centering on, renaming, and deleting: 

1. Right-click on the overlay 
2. Choose one of the above options 

Cutting and pasting: 

1. Right-click on the overlay 
2. Choose Cut (Overlay will disappear from main display but remain in the Overlay 

application) 
3. Right-click elsewhere on the main display  
4. Choose Paste (The overlay should appear in the same location it was cut) 
5. Move to desired position 

Copying and pasting: 

1. Right-click on the overlay 
2. Choose Copy to replicate the overlay 
3. Right-click and choose Paste (Overlay will have the same position as the original. No 

matter where the user left-clicks on the main display the overlay will always appear from 
where it was copied. 

4. Drag new overlay from on top of original to another location (Use center point to drag or 
type in a new location to its editor) 

Distributing an overlay: 

1. Right-click on the overlay 
2. Toggle Distribute on (All network participants will receive a copy) 
3. Toggle Distribute off (Overlay no longer shared on network) 

Flipping and rotating the overlay: 

1. Right-click on the overlay  
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2. Choose the correct and action and direction (Flip will reverse the overlay and Rotate will 
move it 90 degrees in one of two directions) 

2.10 Track Scenario Play/Record 

The Track Recorder (Tracks>>Track Recorder) provides a VCR-like interface to record 
and playback track scenarios (Solipsys-designed data extracts are also known as ‘.dx’). The 
application has an option to playback the recording at .25X to 10X normal speed. Track 
Playback and Record are independent and can be executed simultaneously (See Figure 15). 

In the absence of live data, the playback mechanism may be used to stimulate the display with 
recorded data. Live data is not displayed while recorded data is being replayed. The replayed 
data’s presentation and the user’s ability to interact with it are no different from its live 
counterpart. However, user requests, such as identity assignment requests, will be ignored while 
in the playback mode. The record option records the raw data received by the display.  Any 
display filters active during recording will not affect the recording of data. 
 

 
Figure 15. Track Recorder 

Stopping, playing, fast-forwarding, rewinding, pausing, or replaying: 

Select the appropriate button. The replay option will continuously play the file. Select 
replay before selecting play. 

Recording: 

1. Click on the text field near the label, Record, and wait for a cursor. 
a. Type in a new filename. 

Or  
b. Select one from the pull-down menu in the same location. 

2. Press Record to start or stop recording. The record button will have a red light when 
active. 
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2.11 Range and Bearing Readouts 

TDF uses several methods to determine the bearing and range between any two points or 
objects on the main display (Figure 16). Range and bearing is displayed by dynamically locking 
two or more objects (Figure 17).  

 
Figure 16. Range and Bearing Grid 

Creating Rollover Details windows: 
1. Open Tracks >> Details 
2. Choose Rollover Tab 
3. Left-click on a detail (Altitude, B/R/A from Reference, etc.) in Available Details and press 
Add. 
4. Make sure the Details are toggled on in the All Categories Panel 
5. Select OK. 

Creating Rollover tags: 

1. Open Tracks >> Tags 
2. Choose All tab 
3. Left-click on one or more details from the Available Details and press 
Add. 
4. Make sure the Details are toggled on in the All Categories Panel 
5. Select OK. 
 

Configuring a Pointer tag: 

1. Place a bullseye at the appropriate location on the main display. 
2. Right-click on bullseye and choose lock position from the pop-up menu. 
3. Right-click again and choose Set Reference from the pop-up menu 
4. Open Features >> Range Bearing Grid. 
5. Left-click and drag Reference To Pointer to the top of the list. 



 
  26 

6. Toggle Near Pointer on and Show Bearing Type. 
7. Make sure Reference To Pointer is toggled on. 
8. Make sure visible is toggled on. 
9. Select OK. 

Dynamically locking two or more tracks: 

1. Primary:  
a. Select one at a time: <Shift> + left-click;  
b. Select several in a region: <Shift> + left-click and drag. 

Or 
2. Secondary:  

a. Select one at a time: <Shift> + middle-click (<Shift> + <Alt> + left-click); 
b. Select several in a region: <Shift> + middle-click and drag (<Shift> + <Alt> + 

left-click + drag). 
3. Right-click and choose Add R/B Line in the menu. 

 
Figure 17. Dynamic Locking 

2.12 Partition Display 

When an operator becomes more familiar with the different applications available in 
TDF, a partition display like the one shown in Figure 18 can be used to keep all necessary 
applications where a user needs them—on top.  
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Creating a partition display: 

1. Select the size button near the ‘X’ in the upper-right corner. 
2. Grab the edges of the main window with the double arrow. 
3. Drag to achieve the desired size. 
4. Open several applications, such Track Recorder and Magnifier. 
5. Grab the edges of the application window with the double arrow. 
6. Drag each window to a size that accommodates all the appropriate applications. No 

application window should overlap another. 
7. Ensure that each application still displays the necessary information, because all 

programs reconfigure their own contents dynamically.  

 
Figure 18. Partition Display 

3 TDF IN-DEPTH 

TDF In-depth will take the user deeper into its many components and usages. First, it will 
explore the Control Bar and then the many applications found in the Menu Bar. Depending on 
the configuration, several appendices-- Appendix A – Filters and Properties; Appendix B – Color 
Coding; Appendix C – Battlelab; and Appendix D – PAD--are included to explain further 
capabilities of TDF.  
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3.1 Control Bar 

The Control Bar at the bottom of a TDF display provides quick access to useful 
commands. In the Upper Control Bar, the toolbar includes Range In/Out, Range History, Action 
Toggles, IFF/Friendly Toggles, and Identity Toggles. In the Lower Control Bar, there is a toolbar 
for manually entered display items, a quick range indication and modification tool, "Dynamic 
Coordinates", and the Hook application. The Control Bar may be toggled on or off by pressing 
F4 (default) while the cursor is in the main display. The Control Bar will vary according to the 
user's configuration.  

3.1.1 Upper Control Bar 

 
Figure 19. Upper Control Bar 

Positions: 

• Range In/Out: The magnifying glass (left) with the plus sign ranges in. The magnifying 
glass (right) with a minus sign ranges out.  

• Range History: Range History remembers the exact position of the display for up to 10 
positions. The left arrow goes backward in history or up the History list. The right arrow 
goes forward in history or down the history list. To display history right-click on the Geo 
Locator's coordinates and select History. The top of the list is least recent; the bottom is 
most recent.  

Action Toggles:  

• Tracks: Toggles all tracks on/off, except for Hostile and Force Tell.  
• History: Toggles history on/off. When tracks are hooked and this button is toggled, the 

history will only appear for the hooked tracks. It will persist when deselected until the 
user presses the History button twice.  

• Tags: Toggles tags on/off. When tracks are hooked and this button is toggled, the tags 
will only appear for the hooked tracks. It will persist when deselected until the user 
presses the Tags button twice.  

• Beacon: Toggles all beacon and reinforced objects on/off.  
• Radar: Toggles all radar hits on/off.  
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IFF/Friendly Toggles:  

• IFF: Toggles all tracks with a IFF Mode 1-4 on/off.  
• FND: Toggles all Friendly tracks on/off.  

 
Identity Toggles: When tracks are hooked, these buttons can be used to assign identity to the 

tracks. Below are the abbreviations and spelled-out identities: 
• PND: Pending  
• FND: Friend  
• ASF: Assumed Friend  
• NEU: Neutral  
• UNK: Unknown  
• SUS: Suspect  
• HOS: Hostile 

3.1.2 Lower Control Bar 

The Lower Control Bar (Figure 20) at the very bottom of a TDF display provides quick 
access to useful commands. There is a toolbar for manually entered display items, a quick range 
indication and modification tool, Dynamic Coordinates, and the Hook application. The Control 
Bar may be toggled on or off by pressing F4 (default) while the cursor is in the main display. The 
Control Bar will vary according to the user’s configuration. 

 
 

Figure 20. Control Bar 

3.1.3 Markers 

The Markers application (Figure 21) allows the operator to drop symbols at various 
locations in the main display by selecting a marker located at the lower left of the screen. If the 
airbase pushbutton is pressed, a menu of more pushbuttons will slide out to its right. The chosen 
marker can then be manually inserted into the main display and edited. Use the right-click menus 
to edit the markers. After placement and editing, the markers can be distributed to others on the 
network.  
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Figure 21. Markers Application 

Adding an arrow marker: 

• Left-click and hold the airbase icon. The menu displayed in Figure 21 will appear to its 
right 

• Drag the pointer to the arrow marker releasing only when selection has been made. 
• Left-click on the main display where a marker is required. 
• Right-click on the marker to Set Reference, Slave To, Lock Position, Distributed, 

Delete Point, or Edit Point. 

Depending on the marker, a variety of options and data entry actions are available, 
including a distribution option (via the display network) and/or a send option (via data link). For 
example, the Arrow marker includes an arrow locator mechanism. If the first user distributes an 
arrow to a second user, the second user can find where the arrow marker is by following the 
direction of the arrow locator as is shown in Figure 22. 

 
Figure 22. Arrow Locator 
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3.1.4 Hook 

The Hook application shortcut (Figure 23) allows the operator to search the track 
database for objects containing a variety of conditions, such as DTN, JTN, CU, and IFF Modes 
1-4. All objects, which match the search criteria, are hooked in the main display.  

 
Figure 23. Hook Application shortcut 

If a track needs to be hooked based on some attribute, the operator should use the hook 
window. If an object in the main display needs to hook according to its geographic location, the 
operator should select the object using one of the techniques discussed in Section 2.4. A single 
asterisk ‘*’ by itself may be used to search for all objects that contain the selected condition. 

3.1.5 Keystrokes and Accelerators 

Many keyboard shortcuts, accelerators, and a Key Binder have been added to enable 
efficient interaction with TDF. Table 7 shows the default keyboard shortcuts. Table 8 shows the 
non-configurable mouse operations available in the main display discussed earlier in this 
document. Table 9 and Table 10 list the non-configurable panning and dragging mouse 
operations. Table 11 contains the default accelerator list for standard applications. All of these 
default selections, except for the mouse operations, can be changed in the Key Binder application 
(View>>Key Binder) in the menu bar. Since the TDF application list is plug-in defined, this list 
can vary from system to system.  

Table 7. Keyboard Shortcuts 

 
Keyboard Shortcut Action 
 F1 Help Viewer 
 F2 Reset Pointer Control 
 F4 Toggle Control Bar Display 
 F5 Toggle Menu bar Display 
 -  or Numpad - Range out 
 = or Numpad + Range In 
 J or Left Arrow Move West 
 L or Right Arrow Move East 
 I or Up Arrow Move North 
 K or Down Arrow Move South 
 . Toggle Enhanced Hooked Tracks 

Shift + J Rotate Counter-clockwise 
Shift + L Rotate Clockwise 

 C Toggle Country Colors 
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Keyboard Shortcut Action 
 E Toggle Emboss 
 F Toggle Filters 

G Toggle Range/Bearing Grid 
 H Toggle Track History 
 R Set Reference 
 S Toggle Stars Display 

T Toggle Range Bearing 
0 (zero) Display Preset Eye Positions 
Press 1-9 Jump to Preset Eye Position n 
Press + Hold 1-9 Set Preset Eye Position 

 

Table 8. Mouse Pointer Operations 

 
Mouse Operation Action 
 Left-click Primary Hook 
 Middle-click or Alt + left-click Secondary Hook 
 Shift + left-click + Drag Primary Group Hook 
 Shift + middle-click or 

Alt + Shift + left-click  
Secondary Group Hook 

 Double left-click + Drag or 
 Ctrl + left-click + Drag  

Rubberband Range 

 Right-click Pop-up Menu 
 Double left-click or  
 Ctrl + left-click 

Offset 

 Left-click + Drag  Range/Bearing Indicator 

Table 9. Pan Mode Operations 

 
Mouse Operation Action 
 Double left-click + Drag or 
 Ctrl + left-click + Drag  

Pan 

 Double middle-click + Drag north or 
 Ctrl + Alt + left-click + Drag north 

Recenters On A Point and Zooms In 

 Double middle-click + Drag south or 
 Ctrl + Alt + left-click + Drag south 

Recenters On A Point and Zooms Out 

 

Table 10. Drag Mode Operations 

 
Mouse Operation Action 

Double left-click and Drag or 
 Ctrl + left-click and Drag 

Drags While Retaining Center Pointer 

 Double middle-click and Drag north or Zooms In 
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Mouse Operation Action 
 Ctrl + Alt + left-click and Drag north 
 Double middle-click and Drag south or 
 Ctrl + Alt + left-click and Drag south 

Zooms out 

 

Table 11. Application Accelerators 

 
Application Accelerator Action 
 Ctrl + F Preferences 
 Ctrl + H History 
 Ctrl + K Hook 
 Ctrl + I Information 
 Ctrl + L Track Lists 
 Ctrl + M Geo Options 
 Ctrl + O Overlays 
 Ctrl + P Print 
 Ctrl + Q Quit 
 Ctrl + R Reset 
 Ctrl + T Presentation 
 Ctrl + U Multigraph 
 Ctrl + V Video Switch 

3.1.5.1 Using Key Binding 

Changing the shortcut for the Move North navigation: 

1. Open the Key Binder window (Figure 24). 
2. Left-click inside the second field in the appropriate row. 
3. Press the letter R. 

This will change the shortcut from I to R and will delete any other shortcut that shared 
this letter to eliminate duplications. These shortcuts can be added to any action included in the 
Key Bindings application; any additions an operator makes will alter the default. 
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Figure 24. Key Binder 

3.2 Range Bearing Grid Readout 

The Range Bearing Grid (Figure 25) allows the operator to maintain a convenient grid of 
ranges and bearings in an on-screen display. If enabled, the grid can show the relative positions 
of the primary hook, secondary hook, ownship, a reference point, and the pointer. The reference 
point can be associated with a track or a special point, allowing maximum flexibility.   

 
Figure 25. Range Bearing Grid Readout 

To display the Range Bearing Grid, either select Image Visible from the editor, or use the 
G view key. When the pointer is over the main display, up to four additional pointer lines will 
appear in the grid. Also available in the Editor, a user can set the readout to appear near the 
pointer, which is useful to determine the range and bearing from a given reference point. 

The Pointer is the main navigation tool. As the pointer moves over the display, relevant 
grid line data is automatically updated, allowing the operator to find the ranges and 
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bearings to any item on the display. 
 

The Circle is the active hook primary track. The display shows the active hook concept by 
an especially bold enhancement around the track. 

 
The Square is the active hook secondary track. This secondary icon behaves identically to 
the primary icon above, except it watches the secondary hook. 
 

The Ownship icon denotes the operator’s position. Ownship will only change if the object 
is mobile. 

 
The Reference Point is a specific track or special point that has been chosen by the 
operator.  The default view key R can be used to assign a primary hook to the reference 

point. An alternate method to assign the reference point is to use the context menu over the 
Range Bearing Grid pop-up on the main display. The position of the reference point will follow 
the track or special point to which it was assigned.  A special indicator will appear over the 
display symbol for the reference point. 

The actual Range Bearing Grid display of this information presents all of the 
combinations, up to nine, of the five position types.  In the grid display, the information 
presented is the Bearing from the first icon to the second icon followed by a slash, and then the 
reciprocal bearing (from second icon to the first).  After the bearings, the range is listed. 

Drawing Range and Bearing Lines from one object to another: 

1. Select an object. 
2. Right-click to select ‘lock position’ from the resulting menu. 
3. Drag the pointer from or to the locked object to draw a range/bearing line. 

4 MENU BAR APPLICATIONS 

The following sections describe the applications available from the various pull-down 
menus located on the menu bar, which the operator can toggle on and off with F5 (default). Most 
applications within TDF include similar file and view menus and implementation buttons. 

4.1 Application Menus and Buttons 

4.1.1 File Menu  

The File menu usually contains the items in Table 12: 

Table 12. File Menu 

Command Action 
New Opens a new window or previously saved file. 
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Open Opens a new window or previously saved file and closes 
ones already open. 

Save Saves the file as the original file name. 
Save As Saves the file with a given filename. 
Recent Documents Lists recent documents as shortcuts. 
Close Closes files and windows of a given plug-in. 

4.1.2 View Menu 

The View menu allows the user to select the display on which the settings will be 
applied. Possible options in the default TDF configuration include main display (Tacsit) and 
Magnifier. If the view is set to Magnifier, all configurations made in such programs as Track 
Presentation will only affect the Magnifier application and not the main display.  

4.1.3 Okay/Apply/Revert/Cancel 

In many applications, implementation buttons such as those in Table 13 appear in the 
lower right of the window.  

Table 13. Implementation Buttons 

Button Action 
OK Applies settings and closes window. 
Apply Applies settings but window remains open. 
Revert Resets settings to current state of system. 
Cancel Ignores any changes and closes the applications. 

4.2 System 

The following applications are all available under the System pull-down menu on the 
menu bar. 

4.2.1 Preferences  

The Preferences application (Figure 26) provides operator access to a number of 
configurable options.  Configuration options include animation speed vs. quality, the overall look 
and feel of the application, range and bearing, coordinate system, network distribution, and 
pointer control. An additional option is provided to control whether the information application 
panel comes forward upon selecting objects on the main display. 
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Figure 26. Preferences Application 

 

4.2.1.1 Animation Detail 

The Animation Detail (also in Figure 26) adjustment control enables the user to 
determine how pan and zoom animation modes affect the quality of the display features. When 
the slider is closer to Minimum, more display features will be disabled during the animation, 
permitting a faster animation.  When the slider is closer to Maximum, the display features will 
remain intact, but the animation will be less smoothly rendered. 

4.2.1.2 Appearance 

The entire look and feel of TDF can be altered via the Appearance panel (Figure 27). 
There are numerous appearances supported including Metal, Motif, Solipsys Eclipse, Steel 
(default) and Night. On Windows platforms, the Windows look and feel will also be available. 
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Figure 27. Preferences - Appearance 

4.2.1.3 Bearings 

The Bearings panel (Figure 28) allows the user to select between True and Magnetic 
bearing for bearing calculations within TDF. If Magnetic Bearing is selected, the user may enter 
a declination value (in degrees) to be applied during the bearing calculation processing.   

 
Figure 28. Preferences – Bearings 

When lines are formed between on-screen objects, the Range/Bearing Lines options are 
honored. The check box commands are listed in Table 14.   

Table 14. Range Bearing Commands 

Command Action 
Show Labels Toggles (Displays/Suppresses) text ‘BRG:’ and 
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‘RNG:’ on the range bearing line. 
Show Condensed Format Toggles line break and abbreviates ‘BRG: RNG:’ to 

‘B: R:’ 
Show Origin Toggles latitude and longitude of the origin. 
Show Origin Bearing Toggles bearings from the origin to the destination. 
Show Destination Bearing Toggles bearings from the destination to the origin. 
Show Bearing Type Toggles the True vs. Magnetic indicator on the 

range/bearing line. 
Center Bearing Text Toggles whether the text is centered on the 

range/bearing line or at the end of the line. 

4.2.1.4 Coordinate System 

This panel (Figure 29) enables the user to globally change the coordinate system. The 
available coordinate systems are as follows: Latitude/Longitude (LL), truncated MGRS (Local), 
Universal Transverse Mercator (UTM), and Military Grid Reference System (MGRS). A 
reference point can be established in this same panel using the chosen coordinate system.  

 
Figure 29. Coordinate System 

4.2.1.5 Distribution 

TDF supports the distribution of certain objects across the display network when more 
than one TDF node is online. The Distribution panel (Figure 30) allows the user to register the 
user’s machine on the network to be able to receive and display Special Points and Overlays 
from other, connected operators. When another operator selects an object to distribute, all 
registered operators will receive the Special Points and Overlays at the same point on earth. 
Some versions also include the options of distributing Video Switch and SOLAR ATO messages 
to other operators. 
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Figure 30. Preferences – Distribution 

Distributing a marker: 

• Select a marker, such as the bullseye, from the lower-left Markers Control Panel. 
• Left-click on the main display, and the bullseye will appear on the map. 
• Right-click on the bullseye and select Distribute from the action menu; all persons on the 

network will see this marker at the same location on their display. 
 

4.2.1.6 Pointers 

The Pointer Preference panels (Figure 31, Figure 32, and Figure 33) permit the user to 
customize the various pointer modes available in TDF.  The three modes available are Drag, Pan, 
and Range/Bearing. The Drag Mode panel allows the user to set the zoom speed, allowing 
customization of the perceived magnification rate when using the pointer. 

 
Figure 31. Pointers Panel – Drag Mode 

The Pan Mode panel (Figure 32) also has a zoom speed slider, but it has an additional 
option. The speed can be fixed so the distance the pointer has moved from the selection position 
is not used to accelerate the zoom animation. A pan speed slider is also provided with a constant 
speed control to affect the perceived speed in pan animations. 
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Figure 32. Pointers Panel – Pan Mode 

The Range/Bearing Pointer panel shown in Figure 33 contains checkboxes for the display 
options listed in Table 15. Selecting one or more of these Text Options checkboxes will 
determine what information is displayed with range and bearing lines. The range and bearing 
lines appear on the main display when a user left-clicks and drags the pointer. Choosing a Line 
Option configures the style of these lines.   

 
Figure 33. Pointer Panel – Range/Bearing 

Table 15. Range Bearing/Line Options 
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Text Options Action 
Show Labels Toggles (Displays/Suppresses) text ‘BRG:’ and 

‘RNG:’ on the range bearing line. 
Show Condensed Format Toggles line break and abbreviates ‘BRG: RNG:’ to 

‘B: R:’ 
Show Origin Toggles latitude and longitude of the origin. 
Show Origin Bearing Toggles bearings from the origin to the destination. 
Show Destination Bearing Toggles bearings from the destination to the origin. 
Show Bearing Type Toggles the True vs. Magnetic indicator on the 

range/bearing line. 
Center Bearing Text Toggles whether the text is centered on the 

range/bearing line or at the end of the line. 
Line Option Action 
Line Only Displays range and bearing line.  
Circle Displays range and bearing circle. 
Circle with Compass 
Marks 

Displays a range and bearing circle with compass 
marks. 

4.2.2 Print 

The Print application (Figure 34) allows an operator to print the entire TDF screen 
contents or selected applications. It requires printer support on the hardware platform executing 
the TDF application. After it is commanded to print, the computer's local print screen will 
appear. It will work the same way as other familiar applications. 

 
Figure 34. Print Application 

4.2.3 Reset 

The Reset application (Figure 35) permits the operator to clear the track database, 
essentially reinitializing TDF and clearing the main display of currently held tracks; to 
reinitialize all the sensors being displayed in TDF; and to reset available applications to default. 
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These options are useful when it appears that some track or sensor information may have been 
corrupted; when other systems connected to TDF have been restarted; or when applications have 
been incorrectly configured. A dialog box confirms the operator’s selection.  

 
Figure 35. Reset Application 

Resetting the sensors: 

1. Left-click on Sensors (Use Ctrl + left-click to select more than one) 
2. Press OK 

4.2.4 Status 

The Status application (Figure 36) provides performance, discovery users, memory 
usage, thread status, and track load information associated with the TDF application. The Status 
application is organized into a five-tabbed panel: Discovery, Java VM, Threads, Track, and 
View.  

The Discovery tab shown in Figure 37 displays all of the other users registered via the 
TDF discovery mechanism. Discovery is a Jini-like program able to detect when other users log 
on and off the same network.  
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The Java VM tab provides a real-time graph of used and free memory associated with the 
Java Virtual Machine. The Virtual Machine can be used to determine TDF's performance. The 
larger the number of free bytes, the greater the computer's ability to perform its tasks.  

The Threads tab displays all of the threads currently executing and the group and priority 
of each thread. 

The Track tab displays information related to the total number of tracks in the system. It 
also provides a graph of the track counts over time.  

The View tab gives other performance details, such as the last redraw and the layer on 
which it is drawn. The last redraw value corresponds to the number of milliseconds it took to 
draw the most recent update to the screen. The lowest layer value is usually much larger and 
refers to the draw time for the entire screen, including any geographic imagery. These numbers 
are good indicators of TDF’s overall performance. In order to improve performance, the operator 
could display fewer imagery and map options, use a faster animation speed, or disable the no-
flicker option on the range/bearing grid.  

4.2.5 Quit 

The Quit application (Figure 38) allows the operator to shutdown the TDF application. It 
is equivalent to selecting the Close button on the main TDF window. It closes all windows 
associated with TDF. A dialog is presented to confirm the operator’s selection. Select Yes to 
quit, No to cancel. 

 
Figure 36. Status - System Memory Usage  

Figure 37. Status Current Users on the 
System 
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Figure 38. Quit Application 

4.3 Features 

The following applications are all available under the Features pull-down menu on the 
menu bar. 

4.3.1 Alerts 

The Alert Display (Figure 39) permits the user to manage incoming alerts. Alerts occur 
internally, generated within the TDF application, and externally, originating within an external 
system. Simple alerts can occur when an overlay is defined as a boundary. Alerts will originate 
internally when an object has entered or exited a defined region at certain user-specified 
thresholds. Alerts can be of various types, and are defined by a plug-in system. 

When the user opens the application with an active overlay, the list of alerts will appear. 
The list of alerts is presented in chronological order. Each alert provides detailed information, 
including the category, date and time of receipt, and a description of the alert. Upon selecting an 
alert in the list, the complete alert is displayed in the text panel. After reviewing an alert, the 
operator can acknowledge the alert. In addition, the user may choose to acknowledge all alerts 
currently in the alert list, which removes them from the list. More complex alerts may not allow 
acknowledgment, and require operator interaction. These alerts will not appear in the same list as 
informative alerts. 
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Figure 39. Alert Application 

Alerts can be filtered by a category, such as Warning, Caution, or Advisory, thus 
causing the alert application to not display certain alerts. The Alert Display allows the 
configuring, enabling, or disabling of audible alerts. Audible Alerts enables the operator to 
configure the type and volume of the sounds (wav) when one of the alert states occurs. 

The new logging function records alerts using techniques found in many UNIX 
applications. Writing alerts to file allows later investigations into the alerts record. If a track 
violates a user-specified boundary, a track alert will be created and then saved into the log file 
for later review. 

4.3.2 Details Editor 

The Details Editor (Figure 40) controls both the information displayed in the corners of 
the display called details and the information displayed near a track called tags. Details are 
informative windows that appear in the upper left and right depending on the type of hook, 
primary and secondary, respectively. Tags, on the other hand, are windows displayed within the 
immediate vicinity of a track or marker. 
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Figure 40. Details Editor 

The file and view menus are similar to other applications in TDF. These are discussed in 
the system menu section (See Application Menus and Buttons). The last menu, Type, does 
operate uniquely. The menu enables the operator to select whether to configure tags, selection, or 
rollover. Selecting tags will only affect the tag windows on the main display. Choosing selection 
or rollover makes panels available to configure details windows. Selection is just another term 
for most hooked. On the main display, the selected track or marker is prominently highlighted in 
yellow. Rollover details windows appear in the main display when the user moves the mouse 
pointer over a track or marker without left or right-clicking.  

4.3.2.1 Details 

In Tags, Selection, and Rollover, there will be two basic panels: Details and Properties. 
The Details panel includes a list of available details and a list of chosen details. Available Details 
is a details tree used to configure the information displayed in the details windows on the main 
display. Each detail contains one piece of information about a track, such as identity or category. 
Some details are available in logical groups. For example, details useful in Over the Horizon 
(OTH) operations are grouped in the OTH folder. The UTM, Local MGRS, and MGRS details 
can be added in addition to or instead of geographic position, latitude longitude. 
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Adding details to a specific category: 

1. Left-click the plus (+) symbol to add a detail 
2. Select a detail in the Available Details list. 
3. Press the Add button in the category section. If Unique per Category is selected, then 

choose the Add button according to the different categories. 
4. Left-click Close 

Adding groups of details: 

1. Select a folder of details. 
2. Press Add. 

Or 
1. Hold <Shift> + left-click on more than one detail to get all consecutive details. 
2. Press Add. 

Or 
1. Hold <Ctrl> + left-click to choose details singularly. 
2. Press Add. 
3. Press Close 

After details have been selected from the list, the chosen details may be rearranged to suit 
the user’s needs. 

Rearranging details: 

1. Click the left mouse button and hold on a detail.  
2. Drag the detail up or down in the list. 
3. Release the left mouse button. 

Removing a detail: 

Select the trashcan icon located on the right side of the detail. 

A detail’s characteristics can be changed in the panel directly to the right of the chosen 
detail list. In this panel, style changes, such as font type, color, and size, can be changed. 
Additionally, the units of measures and their color can also be changed by using the pull-down 
menus.  

Configuring a detail: 

1. Select a detail from the chosen list 
2. Configure adjacent panel 
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Table 16. Detail Characteristics 

4.3.2.2 Properties 

The Properties tab gives the user the ability to configure the appearance of the tags and 
details windows. The window outline color, width, pattern, and fill can be configured. Although 
the properties panel persists throughout the Details Editor application, the panel only affects the 
specific type of window. Table 17 describes common options. 

Table 17. Properties  

Properties Action 
Active Toggles detail on/off. 
Color Changes the readout’s color with either a color swatch or a 

RGB slider. 
Font Changes the readout’s size and style. 
Label Color Changes the color of the readout’s label through either a color 

swatch or a RGB slider. 
Label Font Changes size and style readout’s label. 
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Label Visible Toggles label on/off. 

 

 
Figure 41. Properties Tab 

4.3.2.2.1 Tags 

After a selection is made from the Type menu, choose either Tracks or Markers from the 
Type list far to the left. Selecting tracks will only configure tags or details for tracks. Likewise, 
selecting markers will only configure tags and details for markers. Then right-click on the track 
to list the user’s implementation choices. The right-click menu for Tracks contains the options 
described in Table 18. 

Table 18. Tracks Menu 

Menu Option Action 
Category Bindings Applies configuration to specific categories: Air, Land, Surface, 

Subsurface, Reference Point, Emergency Point, EW, Space, and 
Unknown. For example, B/R/A from OwnTrack can be applied to 
Air tracks while geographic position can be applied to Land tracks.  

Group Creates a user-specified group name and group characteristics. A 
group can be Category Bindings, Identity Bindings, and Simple. 
Several groups can be created and then cycled through using the 
Tags button on the Upper Control Bar. 
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Identity Bindings Applies configuration to specific identities. For example, B/R/A 
from Own Track. 

Simple Applies chosen details and their properties to all tracks. 

Creating a set of tag groups: 

1. Choose Tags from the Type menu at the top 
2. Right-click on Tracks from the Types list 
3. Choose Group from pop-up menu 
4. Left-click on the plus symbol at the bottom 
5. Type a name in the text field: State A 
6. Press OK 
7. Right-click on State A 
8. Choose Identity Bindings from pop-up menu 
9. Select Hostile tag to the right 
10. Left-click on plus sign 
11. Double left-click on Identity, Velocity, and Sensor 
12. Press Close  
13. Left-click on Identity and change the font color to blue 
14. Right-click on State B  
15. Choose Category 
16. Select Friend tab 
17. Left-click on plus sign 
18. Double left-click on Identity and Geodetic Position 
19. Press Close 
20. Right-click on State C 
21. Choose Simple from the pop-up menu (This will be the equivalent of OFF) 
22. Press Add 
23. Select OK 
24. Left-click three times on the Tags button in the upper control bar. The tags will cycle:  

a. State A: Hostiles 
b. State B: Friendly air tracks 
c. State C: No tags 

 

The following table describes the right-click menu options for Markers. 

Table 19. Markers Options  

Menu Option Action 
Group  Creates a user-specified group name and group characteristics. A 

group can be Category Bindings, Identity Bindings, and Simple. 
Several groups can be created and then cycled through using the 
Tags button on the Upper Control Bar. 

Simple Applies chosen details and their properties to all tracks. 
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Creating marker tags: 

1. Place markers on main display 
2. Open Marker List 
3. Left-click inside each symbols name field 
4. Type a name for each marker 
5. Close Marker List 
6. Open Details Editor 
7. Choose Tags from Type menu at top 
8. Choose Markers from Type list on left 
9. Right-click on Markers Type  
10. Choose Simple from pop-up menu if not already selected 
11. Left-click on plus sign 
12. Double left-click on Marker Name and Geographic Position 
13. Press Close  
14. Select OK 

4.3.2.2.1.1 Declutter 

The Declutter Tags (Figure 42) function adjusts all window locations to make them easier 
to read. There is a variety of options discussed in Table 20. 

 
Figure 42. Details- Declutter 
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Table 20. Decluttering Options 

Option Action 
Declutter Tags Toggles the decluttering function On and OFF. 
Declutter tags if (n) or 
less are visible 

Will perform decluttering on all tracks once the number of 
tracks on screen exceeds the number inserted into the text field. 
Hide all tags Turns all tags OFF 
Hide excess tags Only shows tags that can be displayed 

without overlap 

If number is exceeded, 

Don’t Declutter Turns Decluttering OFF 
Hide tags that collide Toggles OFF all tags that overlap. 
Line Color Configures the color of the line drawn between the track and its 

detail. 

Figure 43 and Figure 44 show the effect of the decluttering function. Figure 3 shows tags 
without decluttering. Figure 4 illustrates the effects of decluttering. The available tags are now 
readable. Even then, it is best to apply one of the following three methods to declutter tracks.  

• Configure details Selection or Rollover instead of tags 
• Include less information in the windows 
• Zoom in closer to the earth to reduce the number of tracks on screen in tandem with 

lowering the number of tracks before the application reaches its threshold (refer second 
option in above table) 

• Group tags for use with cycling (a method explained in .  
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Figure 43. Without Decluttering 
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Figure 44. With Decluttering 

4.3.2.2.2 Selection and Rollover 

Selection occurs when a track is hooked (See Hooking). Rollover occurs when a user 
place the mouse pointer over a track or marker. Selection and Rollover have nearly the same 
configuration options. The only difference between the two configuration processes is a location 
menu in Rollover. This pull-down menu near the top of the application determines the position of 
the window in relation to the track or marker. The first two check boxes (Primary Visible and 
Secondary Visible) available toggle primary and secondary hooks off and on. 
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Figure 45. Selection Configuration 

 Tracks, Pairing Lines, Engagement Lines, History, Markers, Intercepts, Sensors, and 
Connectivity Lines are all optional types for Selection and Rollover. If Selected is chosen from 
the Type menu at the top and Tracks is chosen from the Types List on the left, the details 
windows that will appear when a track is selected will  

Configuring Tracks on Rollover (Error! Reference source not found.): 

1. Choose Selection from the Type menu at the top 
2. Choose Tracks from the Types list 
3. Left-click on the plus symbol 
4. Left-click on Cross Tell 
5. Press Add 
6. Press Close 
7. Highlight Specific Type 
8. Press the trashcan to the left 
9. Choose font size 12 from the pull-down menu 
10. Left-click the checkbox for bold 
11. Change the Unit Altitude to meters 
12. Select Apply 
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Figure 46. Tracks Configuration  

4.3.3 Talk 

The Talk application (Figure 47) is a chat-messaging program used in coordination with a 
TDF Discovery-actuated network, a Jini-like network user locator. It provides a chat capability 
to add to other network distributions, such as markers and status display functionality. When 
Talk is launched by a user, the application automatically finds and logs in any other user on the 
network. It contains a logging function, so no vital messages are lost for either security or 
reference. 



 
  58 

 
Figure 47. Talk Application  

The Log creates a complete record of all exchanges on the network. All messages are 
time stamped, which adds the time of the receipt of every entry. When activated, the Auto Log 
function found in the Options menu begins logging activity when the program is launched and 
continues until disabled or program closure. The first time File>> New Log is used, a filename 
of the user's choice has to be entered as a default. Options >> Appending Log is a function used 
to add logged information to the end of an already existing log file. This could potentially create 
a log of an entire day or week’s messaging.  

The transcript function, on the other hand, creates a file by concatenating only the 
messages present in the dialogue box. Transcripts will not contain messages from participants 
that a user has chosen to ignore. 

The tree is the hierarchy of groups and participants that can be created, modified, and 
saved. A user can navigate using a combination of clicking your mouse buttons and typing or by 
typing only. By selecting a directory in the far tree structure will select that directory. Double 
left-clicking opens and closes the directories beneath. Groups--otherwise known as a directory--
is a set of members represented by a three-person icon. Members are single users represented by 
a single-person icon. These icons will be highlighted when active and dull when not available. 
When using UNIX commands, a ‘/’ character must precede the command. 

Creating and removing a tree with groups and members: 

Enter the following commands into the entry field under the dialogue box. 

1. “/cd” - change directory to home 
2. “/pwd” - verify the directory 
3. “/mkdir NewDirectory”- creates a directory called NewDirectory 
4. “/cp zagreus NewDirectory” (/cp <UserName> <DirectoryName>)- puts a copy of the 

member, zagreus, into the directory (or group), NewDirectory.  
5. Choose File >> Save Tree As. 
6. Select the trash icon by NewDirectory to delete it. 
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Chatting with a member named Zagreus: 

1. “/emote smiles” - <OwnName> smiles  
2. “Are you there Zagreus?” - Sends a message to everyone highlighting Zagreus 

Navigating a tree using basic UNIX commands: 

• /cd: change directory 
• /pwd: print working directory 
• /emote: portray oneself 
• /ls: list contents of directory 
• /mkdir: make directory 
• /rm: remove file or directory 
• /ring: causes a system beep on the specified users system. See also “/tell” as they are very 

similar in function. 
• /login: reinitiates the login sequence, as if the user has just launched the application 
• /cp: copy a file or multiple files 
• /tell: overrides the home group location and the deafness setting to send a message to 

someone not in your current working group. “/tell everyone” sends a message to all 
members logged in. 

• /help: list of these commands and specific help with a command type: “/help tell” 

4.3.4 Doctrine 

The Doctrine application (Figure 48) adds incredible capability to TDF. Configuration, 
alerts (local and global), actions, and target selection are all possible without human interaction. 
An operator has to create a doctrine or access a doctrine already available; doctrines can be very 
specific or they can be broad in nature. The following instruction will help in understanding how 
to take advantage of this application.  

Keep in mind:  

• Left-click arrow next to conditions and actions to configure them.  
• The addition of conditions and configuring of Pass/Fail actions must be complete for the 

application to function.  
• The application follows this logical path: if this condition is true, then perform the actions 

listed under the Pass tab. If it is not, then perform the actions listed under the fail tab  
• New Track Doctrine: Only reacts to new tracks entering the database that satisfy the 

condition. It will follow the conditions specified and the pass/fail arguments only when it 
first enters the database. On track update, track that recently entered the database will not 
cause it to react.  

• Track Doctrine: As long as the conditions are met, this doctrine will continue to react.  
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Figure 48. Doctrine Application 

Create a New Hostile Recognition Doctrine (Figure 48):  

1. Select File >> Add Doctrine  
2. Type in a name: New Hostiles  
3. Choose a doctrine type: New Track Doctrine 
4. Left-click Add  

a. Note: Active toggles the doctrine on and off.  
5. Change update to 3000 ms (milliseconds)  
6. Select Add statement >> Conditional  
7. Choose the condition, Hostile, and Press Add Filter or double left-click on the condition  
8. Slide right slider down until Pass/Fail tabs appear  
9. Select Pass tab  
10. Press Add Action >> Choose Local Alert  
11. Expand the action by left-clicking the arrow  
12. Choose Warning from Category pull-down menu  
13. Type Hostile Entering Airspace  
14. Select Apply or OK  
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Figure 49. Doctrine Example 

Create a Boundary Sentry (Figure 49):  

1. While in the main display, create an overlay with shortcuts in control bar  
2. Select File >> Add Doctrine  
3. Type in a name: New Hostiles  
4. Choose a doctrine type: Track Doctrine 
5. Left-click Add  

a. Note: Active toggles the doctrine on and off.  
6. Select Add statement >> Conditional  
7. Choose the condition, Overlay, and Press Add Filter or double left-click on the condition 

a. Note: This creates a boundary. 
8. Expand the action by left-clicking the arrow  
9. Press Select button: browse, choose, and left-click select  
10. Slide right slider down until Pass/Fail tabs appear  
11. Select Pass tab  
12. Press Add Action >> Choose Local Alert  
13. Choose Warning from Category pull-down menu  
14. Type Track Entering Boundary $D ($D - displays alert trigger)  
15. Choose Caution from second Category pull-down menu  
16. Type Exiting Boundary  
17. Press Add Action  
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18. Choose Action Generator  
19. Expand the action by left-clicking the arrow  
20. Choose Add from: Action Performed when...  
21. Left-click Applications arrow and select Alerts 

a. Note: Every time a track passes into the boundary the Alerts application is 
launched and/or brought to the front. 

22. Select Apply or OK. 

4.3.5 Magnifier 

The Magnifier (Figure 50) is a separate display that can be configured independently of 
the main display. Configurations performed in applications, such as Track Presentation and Geo 
Options, will affect only one display at a time. Each application will have a View menu that 
allows the user to determine what display the user is configuring. For instance, a user could 
choose the one symbol set for the main display and the other for the Magnifier. Other than 
display options, the magnifier can also be used to declutter congested areas on the main display. 

 
Figure 50. Magnifier 

Implementing different symbol sets in different views: 

1. Open Magnifier (Features>>Magnifier). 
2. Open Track Presentation (Tracks>>Track Presentation). 
3. Choose Tacsit in the View menu. 
4. Select the NTDS symbol set. 
5. Select the implementation button, Apply. 
6. Choose Magnifier in the View Menu. 
7. Select the MS-2525 symbol set. 
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8. Choose the implementation button, OK. The Magnifier and the main display will use two 
different symbol sets.  

The pointer mode is the only navigation tool offered. A user cannot use the pan and drag 
modes in Magnifier, but the action menu (right-click on map) and track menu (right-click on 
track) are both extremely helpful in navigating maps and manipulating tracks. 

Using the Magnifier: 

1. Hold <Ctrl>. 
2. Move the pointer over any area of the main display. 

Centering the Magnifier on a selected position:  

Double left click (<Ctrl> + left-click) on the Magnifier to recenter it. 

Changing the selected position and range scale:  

1. Double left-click (<Ctrl> + left-click) at a desired screen center position on the 
Magnifier. 

2. Drag outward to increase its size and inward to reduce it; the Magnifier will zoom in on 
the defined area.  

Or 
1. Right-click on the Magnifier’s map. 
2. Choose Range In or Range Out to concentrate on an area or track. 

Other Options: 

1. Right-click on the Magnifier’s map. 
2. Choose Slave To in the same pop-up menu to keep the magnifier locked on a track.   

4.3.6 Geo Options 

The Geo Options application (Figure 51) provides the operator the ability to turn on or 
off various geographical features in the main display. TDF can display most of the map products 
available from the National Imagery and Mapping Agency (NIMA), including World Vector 
Shoreline (WVS), ADRG, CADRG, and CIB. Digital Nautical Chart (DNC) is currently in beta 
test and will be released in a future version. The Geo Options application is organized into a 
four-tabbed panel: Grids, Imagery, Maps, and Projection. 
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Figure 51. Geo Options Application - Grids 

4.3.6.1 Grids 

The Grids panel (Figure 52) allows the toggling of latitude/longitude grids and provides 
an option to display the labels associated with grid. Grids can be shown in fine, medium, or 
coarse mode and in rectangles (default) or squares. Colors of both the lines and the labels can be 
changed. Universal Transverse Mercator (UTM) grids are similar in appearance as the Lat/Lon 
Grid and are similarly configured in this panel. The Precision can be set to 1 km, 10 km, and 
Fine. The UTM grid for 1 km will appear when the view is very close to the earth; 10 km when 
farther away, and Fine even farther away.  

 
Figure 52. Grids 
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4.3.6.2 Imagery 

The Imagery panel (Figure 53) shows the list of all available imagery and terrain data. 
Imagery is drawn according to the list. The top data is drawn first, which can be changed by 
selecting and dragging the terrain. Regarding terrain, the application will look for files that are of 
ten-meter resolution first and then progressively get to the least defined resolution, according to 
the list. Most map products are range-sensitive and only appear when at the appropriate range. 
For example, a CIB satellite image can only be used at a close range. The operator should lower 
the range scale if the correct imagery does not display on the main display.  

 
Figure 53. Geo Options – Imagery Tab 

If the user toggles the arrow, editable options will appear (Figure 54). Some Imagery 
types have extents, which can be toggled on/off, along with the Imagery name. The filter section 
allows the user to configure the display of the data in various ways, such as brightness, blue, 
slope shading, and color.  
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Figure 54. Geo Options – Filters 

After the user selects the arrow next to the imagery desired, an asterisk will appear near 
the filters box, which displays filters that enhance the viewing of the product. A panel with at 
least six filters will appear if the user selects the asterisk icon (Figure 55): Brightness, Edge 
Detector, Gray, RGB Brightness, Slope Shading and Use Maps Color.  

Selecting desired map filters:  

1. Select arrow next to map type. 
2. Left-click on asterisk. 
3. Select a filter (it will be highlighted). 
4. Select Add. The filter will appear in the filters box (see Figure 54). 
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Figure 55. Geo Options – Add Filters 

Although most filters can be configured, Edge Detector and Use Maps Color cannot be 
changed. The operator can remove filters by clicking on the trashcan icon to the right of the 
filter. 

Changing a filter’s attributes: 

1. Select the arrow of a configurable filter, such as Slope Shading. 
2. Change Highlight factor somewhere between 0.01-0.1. 
3. Change Shadow factor somewhere between 0.01-0.1. 
4. Click the check box for Smoother Rendering. 
5. Select OK. Since filter order determines what imagery is drawn first, the user may want 

to reorder the filters.  

Changing the filter order:  

1. Select filter. 
2. Drag to another location. 

4.3.6.3 Maps 

The Maps panel (Figure 56) provides the ability to toggle topographical features and alter 
the colors of these features, including Heliports, National Boundaries, Land Masses, Sovereign 
Territories, Territorial Boundaries, Supplemental Boundaries, Lakes and Rivers, Cities, and 
Airports. A variety of similar features can be added to this Maps section. Additional options are 
available by selecting the flip arrow beyond the Color and Visible options.  
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Figure 56. Geo Options – Maps 

4.3.6.4 Projection 

The Projection panel (Figure 57) allows the operator to change the projection algorithm 
used to display maps and other objects on the screen. TDF currently supports four projections: 
Lambert Conformal Conic, Equidistant Cylindrical, Mercator, and Orthographic (default).  

 
Figure 57. Geo Options – Projection 
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4.3.7 Marker List 

The Marker List (Figure 58) program appears under Features in the menu bar. The List 
provides an inventory of all available markers and the tools to modify the list of them. The 
Markers can be sorted, hooked, hidden, filtered, and saved. The Marker List is similar to both 
Pairings List and Track List.  

 
Figure 58. Marker List 

At first, the user will see three tabs, Markers, Filters, and Options on the left, the Marker 
Display on the right, and the Status Footer at the bottom. Completely pluggable, the Marker 
Properties List on the left of the Marker Display enables a variety of plug-ins to be added to the 
Display. The Display is a list of all markers in the database and the recipient of any changes 
made elsewhere in the Marker List. Modifications such as hooking and renaming will affect both 
the list and the main display, but any filters applied to the list will not be applied to the main 
display.  

The Marker Property List on the left of the Marker Display enables a user to add a variety 
of plug-ins to Display. Properties can be selected one at a time or in groups.  

Creating a new Marker List:  

1. Choose Marker List from the Features menu in the main menu bar. 
2. Select one of the following methods to choose a few properties.  
3. Double left-click on desired properties from the Marker Properties List or left-click + 

press Add.  
4. OR Hold Shift + left-click to select more than one property consecutively and press Add. 
5. OR Hold Cntrl + left-click to select non-consecutive properties and press Add.  
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Adding and Removing Properties:  

1. Right-click on the column header.  
2. Select Insert from the pop-up menu.  
3. Select a property from the pop-up menu to insert it into list.  
OR 
4. Right-click on the column header.  
5. Select Remove from the pop-up menu.  
6. Select a property from the pop-up menu to remove it the list.  

Adjusting the Columns:  

1. Left-click + drag one column header to the right or left.  
2. Place the pointer between two columns; it will change into a double arrow  
3. Drag the column's left or right margins to resize. 
4. Choose Options >> Row Height  
5. Move the slider right to increase the size of the rows and left to decrease it  

Sorting by a Property:  

1. Double left-click on the column header until the right sort direction is achieved.  
OR 
2. Right-click on the column header.  
3. Select the desired sort option from the pop-up menu.  

Saving and retrieving a Marker list layout (.prl):  

1. Choose the File menu >> Save As.  
2. Type in a file name and choose Save. 
3. LATER Select the File menu >> Open.  
4. Browse for file, select it, and click Open.  

4.3.7.1 Operations Menu  

The Operations Menu (Figure 59) will contain many different capabilities depending on 
the configuration. Yet, there are five default commands, Center On, Hook, Unhook, Hide, and 
Show All, included in all configurations. These commands permit a user to group and filter 
options. The first two commands, Hook and Unhook, permit the operator to group the tracks 
using point and click methods discussed earlier. The Primary hooking color-code is tan, and the 
Secondary hooking color-code is green. The Hide command filters all selected or unselected 
tracks, as appropriate. The number of Markers that are filtered and ones that are shown are listed 
in the Status Footer. Show All overrides Hide.  
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Figure 59. Operations Menu 

The Status Footer permits controlled updating and freeze-screen capabilities. This gives 
an operator time to deliberate on choices before the tracks in question change position in the 
continuously updating Pairing Display. Without freeze screen, the rows of tracks will move 
throughout the list according to that track's attributes.  

Hooking tracks:  

1. Cntrl + left-click to select a few rows.  
2. Right-click anywhere on the highlighted region.  
3. Choose Hook selection from the pop-up menu.  
4. Choose Primary (Tan) or Secondary (Green) from the sub-menu. The rows hooked in the 

Pairing List should also be visibly hooked on the main display.  

Freezing and hooking tracks:  

1. Toggle Freeze in the status footer ON.  
2. Right-click anywhere on the highlighted region.  
3. Choose Hook selection from the pop-up menu.  
4. Toggle Freeze OFF. Tracks will not update when frozen.  

4.3.7.2 Options Menu  

The Options menu enables the operator to toggle sections of the Marker List:  

1. Toggle Properties to remove the list of track properties (left).  
2. Toggle Status to remove the Status Footer (bottom).  
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4.3.8 Multigraph 

The Multigraph application (Figure 60) provides a flexible way to graph track attribute 
data for numerous hooked objects. It allows the user to place any of the following attributes on 
the X- or Y-axis: altitude, bearing, course, latitude, longitude, range, and speed.  

 
Figure 60. Multigraph Application 

4.3.8.1 View Menu 

The axis selections are found under the View pull-down menu as shown in Figure 61. 
The default option is to graph altitude versus time. 
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Figure 61. Multigraph – View 

The Properties selection permits the user to vary the display properties of the X- and Y-
axis. By default, Multigraph automatically scales the X- and Y-axis based on the range of values 
that are being graphed. The user can clamp or fix the range of values to certain minimum and 
maximum values through this panel. 

Making a new graph: 

1. Select the tracks that need to be graphed. 
2. Choose Altitude from the View pull-down menu as the X-axis. 
3. Choose Time from the same menu as the Y-axis. 
4. Select Time as one minute, so it will register every minute. 

Narrowing the field: 

1. Select Properties from the View pull-down menu and choose Fixed Scale. 
2. Select the Y-axis tab. 
3. Click the check box next to Fixed Scale. 
4. Add a minimum of 100 feet to ensure only aircraft will register. 

4.3.9 Overlay 

The Overlay application (Figure 62) permits the user to create, save, and display overlays 
of various shapes (Four Whiskey, sectors, washers, circles, polygons, rectangles, lines, etc.) in 
the main display. Overlays can be used for any number of applications, which may include 
boundary zones, doctrine areas, op areas, and free-fire zones. They can be either fixed or slaved 
and can be configured to provide operator alerts when objects enter or exit their boundaries.  
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Figure 62. Overlay Application 

4.3.9.1 Overlay – Menu Bar 

The Overlay application (Figure 62) has a menu bar at the top with four pull-down 
menus: File, Edit, View, and Draw. The File menu in Overlay contains the same functions as 
other applications, except for the Revert All option, which returns the overlays to the most 
recently saved state. 

The Edit menu has numerous options including copy, cut, paste, duplicate, delete, create 
a new overlay group, rename an existing overlay group, and center the main display on the 
current overlay.  

The View menu includes checkboxes to toggle the hierarchy tree and the preview, which 
are both toggled off by default. It also includes checkboxes to toggle optimal shape and text 
drawing. 

The Draw pull-down menu provides the ability to flip and rotate the current overlay. 
Overlays can be flipped in both the horizontal and the vertical directions as well as rotated left 
and right 90 degrees.  
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4.3.9.2 Overlay Tree Hierarchy 

The hierarchical tree control (Figure 63) is central to Overlay. Previously created 
overlays can be shown or hidden, either individually or by groups, by selecting the eye icon to 
the left of the overlay name. The blue eye icon indicates that the overlay or overlay group is 
toggled on, while the white eye icon indicates the overlay is toggled off. Click on System to 
highlight every group and overlay in the tree. The system includes all groups, and the groups 
include all overlays. 

 
Figure 63. Overlay – Tree Hierarchy 

The Overlay application supports the creation of user-defined bearing-range grids shown 
in Figure 63. For bearing-range grids, it provides the ability to specify bearing and range 
start/stop positions, deltas, and textual indications. For Four Whiskey grids, the user can specify 
the color, width, height, and increment (in degrees). While the Overlay application is active, the 
currently selected overlays will not draw in the main display. The operator must click outside of 
Overlay for the overlays to draw; however, if the preview option in the view menu is toggled on, 
a small screen with a blue background will appear. To see what is being created, highlight the 
shape name in the tree to display the shape in the preview window.   

4.3.9.3 Creating and Modifying Overlays 

Although configuration choices change per overlay, there are three major tabs: Shape, 
Style, and Extensions. The first tab is very specific to an overlay’s shape. It enables the user to 
configure the position of the overlay on the main display. When a shape is selected, an editor 
appears in the lower, right-hand corner of the overlay control panel. Each shape has its own 
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editor. The shapes are configured with control points. These are located in the tree control. The 
control point editor has a latitude/longitude editor that can change the position of the control 
point. This is equal to dragging the control point on the view, but it allows the user to enter a 
specific latitude/longitude position.  

The Style tab is available for every shape: Fill and Line Style. If the shape can be filled 
with color, Filled will be an option. Text (T icon) also includes a pull-down menu for font type 
and size; toggles for size bold and italics; and a swatch for color. Use Line Style to further 
configure the overlay; change the color, width of the line from four pixels to two, or its template. 
All editors have Apply buttons that must be selected to accept the changes. 

1. Select group to change Style 
2. Toggle Filled on and choose a color 
3. Configure Line Style 

Most shapes also include an Extensions tab used to distribute the overlay to other 
participants on the network. Information in the editor varies from shape to shape. A few 
highlighted shapes are discussed below: 

Creating any overlay shape:  

1. Select group to add an overlay and then select desired shape 
2. Or just select desired shape to create a new group automatically 
3. Left-click in the main display to place overlay 
4. Activate the Overlays window (The overlay panel will fill with any information pertinent 

to that type of shape) 
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Figure 64. Creating a Circle 

The Circle tab includes entry fields to specify the exact locations of the vital points in a 
circle: Radius, Center Point, and Outer Point. 

Create and configure a Circle (Figure 64):  

1. Select Circle icon and draw on main display 
2. View >> Rename Circle to My Circle 
3. Select Circle tab 
4. Highlight My Circle in the tree to alter its radius (overall size) 
5. Highlight Center in the tree to change its lat and lon (location) 
6. Highlight the Outer Point to change its radius( size based on the distance between center 

and outer points) 
7. Choose Apply within window 
8. Choose T from icon bar 
9. Left-click on main display near the circle 
10. Choose position of the left (and only) point either on the main display or within the 

overlays window 
11. Type words or numbers in the text field  

Using Transparency: 

1. Create a circle with directions above 
2. Choose Style tab 
3. Left-click on color swatch 
4. Choose color 
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5. Slide the Transparency Slider to 80 
6. Left-click the x in the top, right-hand corner to close 

 
Figure 65. Style Tab 

Configure Four Whiskey Grid: 

1. Enter a width  
2. Enter a height 
3. Enter an increment (the amount of grid intersections) 
4. Change Style to personal choice 
5. Toggle Distribute on in the Extensions tab 
6. Select Center and Points 1-4  
7. Enter lat/lon locations to the windows 
8. Select Apply 

Creating a Line: 

1. Select the line icon 
2. Place first point on main display 
3. Continue to place subsequent points until desired shape is achieved 
4. Select the pointer icon in the Overlays application 
5. Configure line 

Modify an existing overlay: 

1. Left-click on the desired overlay in the main display or in the tree 
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2. Use the Overlays application to modify the overlay’s attributes 
3. Or right-click on an overlay to access the action menu and select to enact a change. This 

menu offers similar options to the Overlays application 

Changing an overlay’s size: 

1. Left-click and hold the mouse button down 
2. Drag the outer control points of the overlay 

Moving overlay: 

1. Left-click and hold the mouse on the center control point of the overlay until a four-
pointed arrow appears 

2. Move the overlay to the desired location 

Deleting, flipping, rotating, cutting, copying, pasting, or renaming an overlay: 

1. Right-click on the overlay, a pop-up window will appear 
2. Left-click on the appropriate selection in the pop-up window 

Rotating an overlay: 

1. Select the rotator icon near the pointer in the Overlay application 
2. Rotate the overlay on the main display 
3. Select the pointer icon in the Overlay Application 
4. Activate the main display for drawing 

4.3.9.4 Modifying Group Qualities (Boundary) 

Groups are main nodes in the tree. When a group of groups (top of tree) or a group is 
selected, two major characteristics can be applied to all elements within those groups: Category 
and Zone Type. Category describes the relationship the overlay will have with the main display 
or other tracks. The Zone Type is either a boundary or not. The configurable options in these two 
categories are listed in Table 21 below: 

Table 21. Group Configuration Options 

Fixed Fixes current position 
Slaved Slaves overlay to track  
Slaved to 
Heading 

Slaves overlay to the direction the track is 
moving (or front of the track) 

Category 

Slave to Hook If Slaved is chosen, a user can slave the 
overlay to the most highlighted hooked 
track 
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 Slave to 
Number 

If Slaved is chosen, a user can slave to the 
overlay to a specific track. Choose a 
category from the pull-down menu and 
enter the track number or callsign into the 
text field 

None No zone is designated Zone Type 
Boundary Designates a zone that stimulates alerts 

when tracks enter or exit 
Min Minimum altitude threshold to stimulate 

alerts (Does not function when None--
Zone Type--is chosen) 
Right-click on the measurement to change 
its unit of measure 

Altitude 

Max Maximum altitude threshold to stimulate 
alerts 

Min  Minimum speed threshold to stimulate 
alerts  
Right-click on the measurement to change 
its rate 

 

Speed 

Max Maximum speed threshold to stimulate 
alerts 

Creating a boundary alert: 

1. Create an overlay with instructions above 
2. Activate Overlay application 
3. Choose the eye icon in the hierarchy above the shape 
4. Select boundary in the Zone Type pull-down menu. The boundaries of the shape will now 

be the boundaries of the alert field 
5. Add altitude and speed thresholds in the necessary fields if necessary 
6. Select Apply 
7. Open the Alert application 

4.3.9.5 Weapons Engagement Zones 

The Weapons Engagement Zones (WEZ) in Figure 66 are modified overlays in TDF. 
They are highlighted zones proceeding conically in front of a track. These shapes can be slaved 
to the heading of the track, always preceding the track. After a track is hooked in the main 
display and ADD WEZ is selected from the right-click menu, a WEZ can be configured in the 
Overlays application. By default, the WEZ is the second tab in the Overlay application.  
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Figure 66. Weapons Engagement Zones (WEZ) 

Activating WEZ: 

1. Right-click on a track 
2. Select Add WEZ 
3. Open Features >> Overlays application 
4. Select the track number from the tree to change its properties (Choose the top of the tree 

to configure all tracks and the group to configure its tracks) 
5. Refer to Table 21 for option descriptions 

Configuring WEZ: 

1. Select the sector (describes the size of the WEZ) from the tree  
2. Increase radius default value from 25 to 50 in order to enlarge the WEZ 
3. Or decrease its value to shrink the WEZ 
4. Change the span of Angle 1 from 330 to 220 to enlarge the spread of the zone (An entire 

circle is not an option) 

4.3.10 Range Bearing Grid Editor 

The Range and Bearing Grid Editor (Figure 67) provides a configuration mechanism to 
the pop-up grid on the main display.  
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Figure 67. Range Bearing Grid Editor 

4.3.11 Settings 

The operator is presented with checkboxes for the major Range Bearing Grid settings, No 
Flicker and Visible. The No Flicker option allows the operator to take a slight performance 
penalty in order to have the grid not flicker on the main display every time the mouse is moved. 
When a large number of tracks are active, this performance deficit can be quite noticeable. The 
Visible setting toggles the grid in the main display or any other selected View. 

4.3.12 Content Control  

The split panel beneath the settings enables independent configuration of each line in the 
grid. If multiple lines are selected (Cntrl + left-click, Shift + left-click), then the right panel will 
edit all of the selected grid lines.  Using a drag and drop technique, the operator can reorder the 
entries in the selection panel.  

In the editing panel (right side of the panel), it is possible to select all of the display 
attributes for a given line (or group of lines). Table 22 includes configuration options.  
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Table 22. Edit Options  

Options Action 
Color Changes the readout’s color with either a color 

swatch or a RGB slider. 
Font Changes dialog size and style. 
Image Visible Toggles the readout on and off. 
Near Pointer Places the readout near the pointer 
Range Unit Determines unit of measurement used for the final 

range output 
Show Bearing Type Toggles the True vs. Magnetic indicator on the 

range/bearing line. 
Show Destination Bearing Toggles bearings from the destination to the origin. 
Show Labels Toggles (Displays/Suppresses) text ‘BRG:’ and 

‘RNG:’ on the range bearing line. 
Show Origin Bearing Toggles bearings from the origin to the destination. 

Beneath the selection and editing panels lies a Restore Factory Defaults button, which 
restores the original colors, ordering, and fonts from initial installation. Below this button, a 
current view indicator and a set of control buttons are displayed.  

4.4 Tracks 

The following applications are available under the Tracks pull-down menu on the menu 
bar. 

4.4.1 History Presentation 

History Presentation (Figure 68) allows the user to configure the collection, display, and 
color of track history points in a display, including the main display and the magnifier. History 
points are markers that signify a track has been reported at that geographic position. The user can 
select to have history saved for all tracks, no tracks, or selective categories of tracks. In addition, 
a user can code these history points to display any available data, from reporting sensor to 
responsibility. 
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Figure 68. History Presentation 

4.4.1.1 Options 

The Options panel enables the operator to configure what history points are shown on the 
display. A user can select whether or not history points are always shown, never shown, or 
shown only when selected. Figure 68 shows a configuration, which will cause only selected 
tracks to display history, in order to minimize screen clutter. Table 23 gives a brief explanation 
of the options. 

Table 23. History Options 

Options Action 
Visible Turns the history on, off or when a track on the display is selected 

(actively hooked). 
Selectable Makes history points selectable and enables the 

details windows for the point. 
Interaction 

Rollover Enables a user to rollover a history point. 
Draw Lines Toggles lines between history points. Appearance 
Draw Lines when 
Selected 

Turns on lines between history points only 
when selected on the display. 
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4.4.1.2 Symbols 

The Symbols panel (Figure 69) permits a user to configure how history is rendered on the 
screen. With the Size tab, the size of history points appearing on the main display can be 
changed. With the Color tab, the user can color history points according to an available category. 
The categories include Identity and Sensor, among many others (See Appendix B). 

 
Figure 69. History Presentation - Symbols 

Changing the color of history points: 

1. Choose a category to color by, for instance Identity 
2. Left-click on the box next to a history type, such as Pending. 
3. Pick a color from the swatch or choose a specific color from the RGB slider 

4.4.1.3 Global History Options 

The Global History Options panel (Figure 70) controls how TDF collects history. At the 
top of the panel, the user can select a type of collection from the pull-down menu. The collection 
options include No History and Default History.  If No History is selected, a track’s data will be 
lost when new updates occur. TDF runs faster and uses the least amount of memory when No 
History is selected. Default History enables history collection. The other sections on this panel, 
Trim Params, Sample and Segment Type offer configuration options for history compilation.  
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Figure 70. History Presentation – History Collection 

4.4.1.3.1 Trim Params 

History points are eventually dropped. By default, this event occurs based on either the 
time lapsed or the number of points collected. The desired time or number can be decreased or 
increased by moving the slider left and right. For optimization reasons, history is trimmed some 
time after the conditions are met.  

4.4.1.3.2 Sample 

The default history collector can collect every point it receives, or a certain number of 
points. The operator can select Skip Points to configure the desired skip count. 

4.4.1.3.3 Segment Type 

The default history collector has the capability to accept plug-ins that can create segments 
between history points. TDF currently does not have any of these segmentors, so there are no 
available options. 

4.4.2 Hook 

The Hook application (Figure 71) allows the operator to search the track database for 
objects containing a variety of conditions, such as DTN, JTN, CU, and IFF Modes 1-4. All 
objects, which match the search criteria, are hooked in the main display.  If a track needs to be 
hooked based on some condition, the operator should use the hook window. If an object in the 
main display needs to be hooked according to its geographic location, the operator should select 
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the object using one of the mouse techniques discussed in Section 1.3. A single asterisk ‘*’ used 
by itself will search and hook all objects with the condition selected from the pull-down menu. 

   
Figure 71. Hook Application 

If the user rolls over a Details window (available after tracks are hooked), the Details 
screens will darken while two arrows and a menu appears in the upper-left corner of the Details 
screen. An operator can use keyboard strokes, Page Up or Page Down for primary hooks (Shift + 
Page Up or Page Down for secondary hooks), or select one of the aforementioned arrows in the 
details window. The menu icon lists the hooked objects by number, so the user can jump to the 
wanted track without cycling through all hooked tracks. 

4.4.3 Pairing List 

The Pairing List (Figure 72) program appears under Tracks on the menu bar. The List 
provides an inventory of all available pairings data. The operator can configure and manipulate 
the pairings. The Options Menu on the main menu bar allows the user to display all tabs, or 
isolate the tabs and hide the properties and status footer. Using the operations menu (Figure 73), 
the operator can perform various actions to the pairings, which are described below. 
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Figure 72. Pairing List 

At first, the user will see two tabs, Pairings and Filters, on the left, the Pairing Display on 
the right, and the Status Footer at the bottom. Completely pluggable, the Pairing Property List on 
the left of the Pairing Display enables a variety of plugins to be added to the Pairing Display. 
The Pairing Display is a list of all pairings in the database, and the recipient of any changes made 
elsewhere in the Pairing List. For instance, all filters loaded in the Pairing List will not affect the 
processing of pairings on the main display.  

The Pairing Property List on the left of the Pairing Display enables a user to add a variety 
of plug-ins to Pairing Display. Pairing properties can be selected one at a time or in groups.  

Creating a new Pairing List:  

1. Select new pairing list from the file menu. Then, select one of the following methods to 
choose a few properties.  

2. Double left-click on desired properties from the Pairing Properties List or left-click + 
press Add.  

3. OR Hold Shift + left-click to select more than one property consecutively and press Add. 
4. OR Hold Cntrl + left-click to select non-consecutive properties and press Add.  

Adding and Removing Properties:  

1. Right-click on the column header.  
2. Select Insert from the pop-up menu.  
3. Select a property from the pop-up menu to insert it into list.  
OR 
1. Right-click on the column header.  
2. Select Remove from the pop-up menu.  
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3. Select a property from the pop-up menu to remove it the list.  

Adjusting the Columns:  

1. Left-click + drag one column header to the right or left.  
2. Place the pointer between two columns; it will change into a double arrow  
3. Drag the column's left or right margins to resize.  

Sorting by a Property:  

1. Double left-click on the column header until the right sort direction is achieved.  
OR 
1. Right-click on the column header.  
2. Select the desired sort option from the pop-up menu.  

Saving and retrieving a Pairing list layout (.prl):  

1. Choose the File menu >> Save As.  
2. Type in a file name and choose Save. 
LATER 
3. Select the File menu >> Open.  
4. Browse for file, select it, and click Open.  

4.4.3.1 Operations Menu  

The Operations Menu (Figure 73) will contain many different capabilities depending on 
the configuration. Yet, there are five default commands, Center On, Hook, Unhook, Hide, and 
Show All, that are included in all configurations. These commands permit a user to group and 
filter options. The first two commands, Hook and Unhook, permit the operator to group the 
tracks using point and click methods discussed earlier. The Primary hooking color-code is tan, 
and the Secondary hooking color-code is green. The Hide command filters all selected or 
unselected tracks, as appropriate. The number of Pairings that are filtered and ones that are 
shown are listed in the Status Footer. Show All overrides Hide.  
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Figure 73. Operations Menu 

The Status Footer permits controlled updating and freeze-screen capabilities. This gives 
an operator time to deliberate on choices before the tracks in question change position in the 
continuously updating Pairing Display. Without freeze screen, the rows of tracks will move 
throughout the list according to that track's attributes.  

Hooking tracks:  

1. Cntrl + left-click to select a few rows.  
2. Right-click anywhere on the highlighted region.  
3. Choose Hook selection from the pop-up menu.  
4. Choose Primary (Tan) or Secondary (Green) from the sub-menu. The rows hooked in the 

Pairing List should also be visibly hooked on the main display.  

Freezing and hooking tracks:  

1. Toggle Freeze in the status footer ON.  
2. Right-click anywhere on the highlighted region.  
3. Choose Hook selection from the pop-up menu.  
4. Toggle Freeze OFF. Tracks will not update when frozen.  

4.4.3.2 Options Menu  

The Options menu enables the operator to toggle sections of the Pairing List:  

1. Toggle Properties to remove the list of track properties (left).  
2. Toggle Status to remove the Status Footer (bottom).  

3. If both are toggled off, the Menu bar, Pairing Display, and Pairings/Filters tab remain. 
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4.4.4 Track Presentation 

Track Presentation (Figure 74) provides a large number of controls for customizing the 
display of track information in the main display. The application is organized into a three-tabbed 
panel: Features, Filters, and Symbols. 

 
Figure 74. Track Presentation 

4.4.4.1 Features 

The Features panel (Figure 75) enables the user to toggle Velocity Leaders and Heading 
on and off. If the velocity leaders are clicked on, the user can specify the length in seconds (0 – 
1020 seconds). The user can also indicate the color of velocity leaders by selecting the color box 
underneath. Color options include a swatch grid or RGB capabilities for precise color choice. 
Heading allows the user to choose the length and the color of the track heading line in pixels (0-
50 pixels). 
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Figure 75. Track Presentation - Features 

4.4.4.2 Filters 

The Filters panel (Figure 76) contains two sections, the available filter list section on the 
left and the expression builder tabs for Always/Never Show on the right. These sections permit 
the operator to filter the display of information on the main display through track property 
specification and logical expressions utilization. (See Appendix A for a list of filters). 
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Figure 76. Track Presentation - Filters 

4.4.4.2.1 Filters List 

The Filters section includes filters, such as Category, Identity, IFF, Sensor, etc. These 
conditions are pluggable and extensible. Contact Solipsys for more information about additional 
plug-ins. A user must first select either the Always Show or the Never Show tab, depending on 
the change required. Always Show will always show a particular type of track. Never Show will 
never show it. Never Show is always processed before Always Show and will cancel out 
competing elements in Always Show. The Force Tell condition trumps all other filters. 

After the expression has been chosen, an operator can select a filter from the Filter List, 
select either the Never Show or the Always Show tab, and then left-click the Add Filter button 
located beneath the list (or double left-click on the filter in the filter list). The filter will appear in 
the tab on the right side of the panel. The condition can then be refined, the category or identity 
can be selected, the IFF mode can be entered, etc. The refinement controls are condition-
dependent; the options presented to the user are dependent on the type of condition. Filters can 
be easily removed by selecting their respective trash icon. 

Using filters: 

1. Select either Never Show or Always Show. 
2. Double left-click (or left-click + press Add) on a condition, such as Sensor. 
3. Select the Spy 1B radar in the pull-down menu. 
4. Select Apply. 
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4.4.4.2.2 Simple and Complex 

The Filter List contains two types of pluggable filters, simple and complex. These enable 
adjustment of track types on the main display.  Simple filters usually require little user input, 
whereas complex filters require much more.  A simple filter is displayed and refined in a single 
region.  A complex filter is displayed in two portions: a description portion and a drop-down 
portion. The description portion allows the user to enter appropriate data into a field. The drop-
down portion is accessed by selecting the arrow, which lies at the extreme left of the filter. A 
checkbox indicates the status to the user who can activate or deactivate any filter without 
removing it from the secondary box.  

4.4.4.2.3 Logical Expressions 

Logical or Boolean expressions permit the operator to make certain specific choices 
about the tracks displayed on the main display. All conditions on the top level of the expression 
builder are treated equally and are considered logically bound or ‘Or-ed’ together. These 
operators, And/Or/Not, create compound expressions: TDF ‘And’ MSCT, TDF ‘Or’ MSCT, one 
or the other, especially useful when one is not available, TDF ‘Not’ MSCT. The logical operators 
can be added to the configured list.  

Using filters, logical operators and conditions: 

1. Select either Never Show or Always Show. 
2. Select logical operator, Not. 
3. Double left-click on operator (or press Add). It should be highlighted in blue. 
4. Double left-click on a condition, such as Identity/Category. 
5. Select Suspect and Unknown in the pull-down menus.  
6. Select Apply. These above choices state that, “TDF will never not show tracks that are 

suspect and unknown; it will always show them.”  

4.4.4.3 Symbol Sets 

The Symbols panel (Figure 77) will appear by default when this application is opened. It 
allows the user to modify the symbol set used in the main display. By default, TDF supports 
several popular symbol sets, including Block, MCE, MIL-STD-2525a, MIL-STD-2525b, and 
NTDS. Because symbol sets are plug-ins, please contact Solipsys for new symbol set additions. 

The symbol sets present the user with a variety of options that are easy to use.  By 
selecting any symbol in the NTDS and MCE symbol sets, the operator can change the size 
(Large, Normal, and Dot) of these symbol sets based on the Model 5 taxonomy category and 
identity. The Block and MIL-STD-2525a symbol sets allow toggling between a large symbol and 
a dot. If a user left-clicks on a row or column, it will cause all symbols in the row/column to 
change in unison while a click on the unmarked region at the upper left of the table will change 
the whole table. 
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Figure 77. Track Presentation - Symbols 

4.4.4.3.1 Block Symbol Set 

The Block Symbol Set (Figure 78) can only appear as either a symbol or a dot. The user 
can change the size (large and dot) by clicking on the empty space between the row and column 
headings (top left). Select a row or column heading to change that entire row or column’s size. 
Clicking on an individual symbol in the grid will change individual track types, such as 
Air/Assumed Friend. 
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Figure 78. Track Presentation – Block Symbol Set 

The user can change the color of these symbols by selecting the color tab. By left- or 
right-clicking on any color box to the left, an operator can access a color swatch and RGB slider 
to have an endless variety of color choices. For instance, a user can configure the color by source 
type (See Appendix B). 

4.4.4.3.2 Mission Control Element (MCE) Symbol Set 

The operator can change the symbols’ size (large, small, and dot) by clicking on the 
empty space between the row and column headings (top left). Select a row or column heading to 
change that entire row or column’s size. By clicking on the object with the mouse, it will change 
individual track types, such as Air/Assumed Friend (Figure 79). 

The color of these symbols can be configured in the color tab. By left- or right-clicking 
on any color box to the left, the operator can access a color swatch and RGB slider to have an 
endless variety of color choices. For instance, the user can configure the color by source and 
radar source type (See Appendix B). 

Configuring MCE Color: 

1. Choose MCE in the available Symbol Sets. 
2. Select the color tab. 
3. Choose MCE in the pull-down menu. 
4. Move slider from left (Darker) to right (Lighter). 
5. Select Apply. 
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Figure 79. Track Presentation – MCE Symbol Set 

4.4.4.3.3 MIL-STD-2525a Symbol Set 

The MIL-STD 2525a (Figure 80) is the first of its kind, specifically created for coalition 
forces, nationally and internationally. The symbols can only appear as either a symbol or a dot. 
The user can change the size (large and dot) by clicking on the empty space between the row and 
column headings (top left). Select a row or column heading to change that entire row or 
column’s size. Selecting an individual symbol in the grid will change individual track types, such 
as Land/Hostile. 

The Color tab allows the user to color-code the symbol set with a property. For instance, 
the operator can choose colors to identify different sources available. The reported sources will 
cause History points to precede the track. The user can choose both Color By, which is the fill 
color and Outline By, which is the outline color  (See Appendix B). 
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Figure 80. Track Presentation – MS-2525a Symbol Set 

This symbol set uses both somewhat unusual shapes and imbedded icons to accurately 
display a track’s attributes. The Appearance tab shown in Figure 81 provides the user the ability 
to choose how the symbol will appear and what icons will be used. The Sample box previews 
what changes have been made. If under the symbol, it reads, <Icons Off>, the operator can 
toggle it ON by enabling the icons-drawn box below.  

 
Figure 81. Track Presentation - Appearance  
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Table 24. Track Presentation Type and Related Actions 

Type Action 
Drawn Toggles any text or symbol inside of the original 

symbol (internal symbol). 
Labels 

Color Changes color of text or symbol drawn in internal 
symbol. 

Drawn Toggles external symbol’s frame. 
Use Default 
Colors 

Uses default colors. 
Frames 

Filled Fills external symbol. Filled is automatically toggled on 
when drawn is chosen, can be toggled off to retain only 
a frame. The pull-down menus offer Color (fill Color) 
and Outline Color. Choose ‘Use Track Color’ to restore 
default colors. 

Icons Drawn Toggles icon’s frame. 
 Use Default 

Colors 
Uses default colors. 

 Filled Fills icon. Filled is automatically toggled on when 
drawn is chosen, can be toggled off to retain only an 
icon’s frame. The pull-down menus offer Color (fill 
Color) and Outline Color. Choose ‘Use Track Color’ 
to restore default colors. 

Sample Uses selectable headings to cycle through symbols 

The Frames box enables/disables a frame around the icon via the drawn check box. In 
addition, the user can toggle the Fill Color of a frame around the icon. In the case of a multitude 
of tracks, it may be necessary to clean up the screen so use this symbol set without color fill. 
This helps prevent ocular confusion. Of course, the user can also remove the icons and change its 
fill color in the Icon box at the bottom of this pop-up screen. This could help one focus on a 
track’s identity and not its platform.  

Configuring a symbol:   

1. Choose Drawn in the Frames section 
2. Turn off Fill Color 
3. Left-click on the pull-down menu called Outline Color and choose Outline Color (border) 
4. Uncheck Drawn in the Icons section to eliminate all icons. The user has made a symbol 

with thin blue frames and no icons, useful to focus entirely on track identity. 

4.4.4.3.4 MIL-STD-2525b Symbol Set 

The MIL-STD-2525b is the next iteration of the 2525 series. The set, based on NATO 
STANAG standards, will replace MIL-STD-2525a as a common symbol set for US and coalition 
forces. Solipsys will include both 2525a and 2525b in the upcoming builds of TDF and 
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BattleLab. The Solipsys 2525b editor (Figure 82) found in the Track Presentation application 
implements this symbol set via a rule system. Please refer to the MIL-STD-2525b for any 
questions regarding Code implementation. Use the three tabs, Rule, Appearance, and Size, to 
configure the symbols.  

 
Figure 82. MS-2525b Editor – Rule Tab 

Configuring Rule #1 (Figure 82): 

1. Select MIL-STD-2525b from menu 
2. Select the Rule tab 
3. Left-click Add located at the bottom of the editor to add rule. 
4. Select the arrow near Rule #1 to open the editor. 
5. Rename Rule #1 to Friendly Air Fighter in the text field. 
6. Enter code listed in MIL-STD-2525b. 
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Figure 83. MS-2525b Editor – Appearance Tab 

Configuring appearance (Figure 83): 

1. Select the Appearance tab 
2. Select Icons>>Drawn to display its center symbol, such as F for Fighter 
3. Select Frame>>Drawn to frame the shape if it is an available option for symbol type 
4. Enable Anti-aliasing to smooth the borders of each symbol. Figure 84 shows the effects 

of anti-aliasing 

 
Figure 84. Anti-aliasing/Aliasing 

Choosing a size (Figure 85): 

1. Select the Size tab 
2. Select Normal for immediate recognition of symbol 
3. Select Dot to de-clutter screen 
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4. Select scale and use slider for shrinking or enlarging symbols 

 
Figure 85. MS-2525b Editor – Size tab  

 Using new rules: 

1. Choose Add to add a dissimilar rule 
2. Choose Duplicate to reconfigure selected rule 
3. Left-click on the trashcan to delete rule 
4. Order rules sequentially. If two rules are similar and if the code (or condition) of 

the first one is met, the second rule will not be considered. 

4.4.4.3.5 Naval Tactical Data System (NTDS) Symbol Set 

The user can change the size (large, small, and dot) of NTDS (Figure 86) symbols by 
clicking the empty space between the row and column headings (top left). The size of symbols in 
a row or a column can also be changed by selecting the row or column heading. By clicking on 
the symbol, the user can change individual tracks in the symbol grid, such as Surface/Friend. The 
Fill Color check box toggles fill color on and off. 

The color of these symbols can be configured by selecting the color tab. By left- or right-
clicking on any color box, the operator can access a color swatch and RGB slider for an endless 
variety of color choices. For instance, an operator could color a symbol set to show a track’s 
radar source type. 
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Figure 86. Track Presentation – NTDS Symbol Set 

4.4.5 Track Recorder 

The Track Recorder (Figure 87) provides the user a configuration similar to home 
electronics to record and playback track scenarios (known as Solipsys-designed data extracts or 
DXs). All selections made will be reflected in the Track Recorder status screen. In addition to 
basic recording and playback, the application has an option to playback the recording at .25X to 
10X normal speed. Track record and playback are independent and can be executed 
simultaneously. By clicking in the Record filename field, the operator can change the name of a 
file being recorded. 

 
Figure 87. Track Recorder 
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4.4.6 Sensor Presentation 

The Sensor Presentation (Figure 88) application controls the dynamic display of 
correlated and uncorrelated radar hits and IFF signals. The sensor presentation can use any 
sensors included in the Multi Source Correlator Tracker (MSCT) and any other data sources 
networked. All available sensors are listed to the left--Alpha, Bravo, etc. Use the Master 
Visibility checkbox to disable all sensors.  

Radar hits, beacon hits, and reinforced hits (beacon hits with a skin painting) can be 
configured in the sensor presentation for display on the main display. These symbols can be 
changed according to correlated and uncorrelated hits.  

Three very useful options appear at the top of the panel: Master Visibility - toggles all 
history off/on; Visibility Cutoff  - configures the distance at which sensors stop displaying; Open 
Edit >> Global Options – provides a slider that globally (the network distribution) changes how 
much history is shown by each sensor.  

 
Figure 88. Sensor Presentation 



 
  105 

History points are controlled by the History tab. If history is turned off, the less recent 
history in the Sensor Presentation will not appear. In the History tab, there are five History 
choices accessible via the pull down menu: 

Choosing a history type: 

1. Cycling: Cycles from front to back on sensor trail 
2. Fade: sensor hits only stay active for a small period of time 
3. No History: Does not display history 
4. Pulsate: Blinks through sensor trail and blinks entirely off for a extremely short period 
5. Ripple: Also blinks through entire trail but stays lit 

Using the Interaction tab: 

• Selectable: Shows sensors when hooked. Useful for decluttering, but not helpful if 
sensors are active for all tracks. 

• Rollover: When the pointer grazes over a track, sensors are displayed. 
• Interact with Current Only: Only allows interaction within a certain range. Right-click on 

NM to change the measurement. 

 
Figure 89. Sensor example 

Creating a sensor configuration: 

1. Choose a sensor in the list. 
2. Left-click on Color square to change it to blue, for instance. 
3. Toggle Filter History Separately if necessary. 
4. Select the History tab. 
5. Select Ripple from pull down menu. 
6. Use slider to pick an appropriate speed. 
7. Press implementation button, Apply. 
8. See the result in Figure 89. 
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4.4.7 Filters 

The third and fourth panels are present to filter the tracks from the main display. The 
fourth only deals with the history plots whereas the third filters all sensor hits. Filters enable an 
operator-chosen variety of conditions and logical operators to narrow the track information to the 
most useful tracks. The Filters here operate just like the filters in Track List and the Track 
Presentation. 

The Filter Display contains two tabs, Always Show and Never Show, which allow the 
operator to narrow tracks through use of these tabs and filters. A useful technique to display only 
one or a few categories of tracks is to use the Boolean expression, not, on the Never Show Tab.  

Filtering a sensor source: 

1. Choose either Filter tab. 
2. Select Never Show. 
3. Double left-click on a filter, use Beacon. 
4. Select Apply. Now, no beacon sensor hits will appear on the display 

4.4.8 Track Counts 

The Track Counts (Figure 90) produces a grid of information to number how many 
tracks of a certain type are currently displayed. This application has four tabs: Track Counts, 
Rows/Columns, Global Filters, and Options. The Track Counts tab is the grid that contains the 
track numbers. The Update Now button at the bottom of the window will do just that; it will 
update the tracks immediately no matter what the update rate. By default, tracks are numbered by 
two values, Category and Identity. Altering the axis (x, y) values is accomplished in the next 
tab, Rows/Columns.  
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Figure 90. Track Counts 

4.4.8.1 Rows/Columns 

The Rows/Columns tab can be configured to include many different conditions and 
logical operators.  

Changing the row and column headings: 

1. Choose Rows/Columns tab. 
2. Choose several headings. 
3. Hold <Shift> + left-click on more than one heading to get all consecutive headings. 
4. Select Add in the Rows or Columns box. 

Or 
3. Hold <Ctrl> + left-click to choose headings singularly. 
4. Press Add in the Rows or Columns box. 

Changing a heading’s name: 

1. Select a heading in a Row or Column Box. 
2. Enter in a new name in the row or column text field at the bottom of the window. 

4.4.8.2 Global Filters 

The Global Filters tab (Figure 91) enables a user to specify what tracks are displayed in 
the Track Counts grid. By default, true is set as a default filter in the Count tab, which should be 
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understood as Count Only. The Never Count tab filters out all the tracks that are identified 
through the addition of filters.  

 
Figure 91. Track Counts – Global Filters 

Changing the row and column headings: 

1. Left-click on filter + press Add Filter (double-click).  
a. Hold <Shift> + left-click on more than one heading to get all consecutive 

headings. 
b. Select Add in the Rows or Columns box. 

Or 
c. Hold <Ctrl> + left-click to choose headings out of order. 
d. Press Add in the Rows or Columns box. 

2. Select appropriate choice in pull-down menu if necessary. 

Changing the order of the table items, simply: 

Left-click and drag the property from one position to another. 

4.4.8.3 Options Editor 

The Options Editor (Figure 92) utilizes a slider, so the user can change the update time 
for the Track Counter. Moving the slider to the right will lengthen the update rate and moving it 
to the left will shorten the update rate. If an operator toggles the Auto Update off, the Track 
Counter will not update unless the Update Now on the Track Counts tab is selected. 
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Figure 92. Track Counts – Options Editor 

4.4.9 Track List 

The Track List (Figure 93) pop-up window appears under Tracks on the menu bar. The 
List provides an inventory of all objects available on the main display. This window includes an 
application-specific menu and three tabs, Content, Filters, and Options.  

 
Figure 93. Track List   
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4.4.9.1 Options Menu 

The Options menu enables the operator to configure the Track List. Selecting Properties 
will remove the list of track properties to the left of the screen. Disabling Status will turn off the 
Status Footer at the bottom of the screen. Selecting Hide All Controls does just that, it hides all 
controls, everything except for the Content Display. 

4.4.9.2 Content  

Under the default tab, Content (Figure 94), the user will see the Track Property List, 
Content Display, and Status Footer. Completely pluggable, the Track Property List on the left of 
the Content Display enables a variety of plug-ins to be added to the Content Display. The 
Content Display is a list of all tracks (objects) available, and the recipient of any changes made 
elsewhere in the Track List. No filters used in the Track List will be used in processing tracks on 
the main display.  

 
Figure 94. Track List - Content Display 

Adding and Removing Property to the Content Display: 

1. Left-click on filter selection + press Add or Remove (double-click).  
Or 

2. Hold <Shift> + left-click on more than one heading to get all consecutive headings. 
3. Press Add or Remove. 

Or 
4. Hold <Ctrl> + left-click to choose headings out of order. 
5. Press Add or Remove. 
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4.4.9.2.1 Content Display 

The Content Display, shown in Figure 95, permits varied manipulations to the data. A 
left-click and drag of any highlighted column heading will alter its position. A right-click on the 
heading provides a cascade menu displaying commands, Insert, Remove, and Sort. Insert adds 
columns while Remove subtracts them from the Content Display. Sort permits the user to sort 
the entirety of the track list based on the chosen column’s attributes in ascending (0-10) or 
descending (10-0) order. The chosen column’s heading will be emboldened and have an arrow 
on the right of the heading box, which designates the direction of sort. Only one column may be 
sorted at a time. 

4.4.9.2.2 Operations Menu 

The Operations Menu will contain many different capabilities depending on the 
configuration. Yet, there are four default commands, Hook, Unhook, Hide, and Show All, on the 
right-click operations menu (also Figure 73) that are included in all configurations. These 
commands permit grouping and filtering options. The first two commands, Hook and Unhook, 
permit the operator to group the tracks using point and click methods discussed earlier. The 
Primary hooking color-code is tan, and the Secondary hooking color-code is green. While the 
hooking commands directly reflect what is occurring in the main display and vice versa, the 
Track List filters and the main display filters are completely independent of each other. The Hide 
command filters all selected or unselected tracks, as appropriate. The numbers filtered and 
shown are listed in the Status Footer while Show All in this cascade menu will undo this filter. 
Some of the operations menu selections may not be available in certain TDF configurations. 

 
Figure 95. Track List – Operations Menu 
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4.4.9.2.3 Status Footer 

The Status Footer includes Tracks, a small box numbering Showing and Filtered tracks; 
and Display, which permits controlled updating and freeze screen capabilities. This gives an 
operator time to deliberate on choices before the tracks in question change position in the 
continuously updating Content Display. Without freeze screen, the rows of tracks will move 
throughout the list according to that track’s attributes. 

4.4.9.2.4 Filters 

The second panel, Filters (Figure 96), offers the ability to remove any tracks from the 
Content Display deemed unnecessary to the operator. Filters narrow the track information to the 
most useful tracks. The Track List Filters operate in the same manner as the filters in the Track 
Presentation, but as mentioned above, are completely independent of each other. 

 
Figure 96. Track List – Filters 

The Filter Display contains two tabs, Always Show and Never Show, which allow the 
operator to narrow tracks through use of these tabs and filters. A useful technique to display only 
one or a few categories of tracks is to use the Boolean expression, not, on the Never Show Tab. 
The Always Show tab lists Hostile and Force Tell objects by default. 

4.4.9.3 Options 

The last tab on the Track List is the Options (Figure 97) panel, which enables the 
operator to control screen updates and sort options. The slider on the top permits the operator to 
change the update rate from one second to 120 seconds. The first check box, Update immediately 
on Track Add/Remove, will cause the Track List application to update its display whenever a 
track is added or removed from the system, rather than waiting until the update time interval on 
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the slider is reached. The last check box, Nulls Sorted High, causes a column to remain at the 
end of an ascending sort. 

 
Figure 97. Track List – Options Panel 

This section describes the steps required to create a sample Track List. 

Making a Track List: 

1. Select new track list from the file menu. 
2. Double left-click on desired properties from the Track Properties List. The Symbol 

property is useful to compare with the main display.  
Or 

1. Hold <Shift> + left-click on more than one heading to get all consecutive headings. 
2. Press Add. 
Or 
1. Hold <Ctrl> + left-click to choose headings out of order. 
2. Press Add. 

Adjusting the Columns: 

1. Left-click on a column header and hold. 
2. Drag it to the to the left or right. 
3. Drag the column’s left or right margins to resize.  

Adding and Removing: 

1. Right-click on the column header.  
2. Select Insert from the pop-up menu. 
3. Select a property to insert from the pop-up menu.   

Sorting by a Track Property: 

1. Double left-click on the column header until the right sort direction is achieved. 
Or  
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2. Right-click on the column header.  
3. Select the desired sort option from the pop-up menu.  

Hooking tracks: 

1. Select a few rows from the table by Ctrl + left-clicking on them.  
2. Right-click anywhere on the highlighted region. 
3. Choose Hook selection from the pop-up menu. 
4. Choose Primary (Tan) or Secondary (Green) from the sub-menu. The rows hooked in 

the Track List should also be visibly hooked on the main display.  

Freezing and hooking tracks: 

1. Toggle Freeze in the status footer to ON. 
2. Right-click anywhere on the highlighted region. 
3. Choose Hook selection from the pop-up menu. 
4. Toggle Freeze OFF. Tracks will not update when frozen.  

4.4.10 Track Options 

The Track Options (Figure 98) application directly affects applications that use track 
conditions and filters, allowing the user to add, remove, and edit information relating to 
Cooperating Unit (CU), Sensor Unit (SU), and Reporting Responsibility (RR). This is a 
convenient application for mapping numerical values to string names for greater reader 
comprehension. These values are then used by other applications. For example, by assigning 
names to each sensor unit, the user can configure the history application to color code the units 
by the sensor names for a more meaningful representation.  

This application has a menu bar at the top of the panel. The panel is split in two: a list of 
editable items on the left, and an editor area on the right. Selecting an item in the list displays its 
editor in the area to the right.  

 
Figure 98. Track Options 

Adding a new track: 

1. Select CU, SU, or RR. 
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2. Select Add. 
3. Enter new track information into the pop-up window. 
4. Choose Duplicate to make a copy of a pre-existing track. 
5. Use a number different from the original in the dialog box. 

Editing a row: 

1. Double left-click on desired cell to edit directly. 
Or 

2. Choose Edit near the bottom. 
3. Type in new values into pop-up window. 
4. Select Delete to automatically delete without a confirmation window. 

4.5 View 

The following applications are available under the View pull-down menu on the menu 
bar. 

4.5.1 Key Bindings 

In the View Keys (Figure 99) application, the user can enter up to two new shortcuts. 
These shortcuts can be called from the main display, but they will not work if another application 
is active.  

 
Figure 99. View Keys 
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Changing a shortcut: 

1. Left-click inside either field to the right. 
2. Press the letter or use a combination, such as <Shift> + T. This automatically deletes 

original shortcut. Forced capitalization is in effect. 

4.5.2 View Locator 

The View Locator (Figure 100) application provides the user with a simple database of 
previously stored geographical locations. The Locator is accessible by using the shortcut, Shift + 
L (default), selecting View Locator from the menu bar, or pressing the globe icon in the control 
bar. The user can offset to previously stored locations by either double left-clicking on the 
location entry in the scrolled list or highlighting the option and pressing the Go To pushbutton.  

 
Figure 100. View Locator 

Saving locations to the database: 

1. Press the Add pushbutton.  
2. Enter appropriate name and lat/lon information into the dialog box shown in Figure 101.  

 
Figure 101. View Locator – Add 
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The application also provides the ability to modify and delete locations selected in the 
scrolled list. 

5  HELP 

5.1 Help Viewer 

The Help Viewer (Figure 102) is an application that runs inside of TDF. It has helpful 
hints regarding every part of TDF although it does not include techniques and strategies for more 
complex usages. 

 
Figure 102. Help Viewer 

5.2 About TDF 

The About (Figure 103) application presents the user with a three-tabbed card that 
indicates the current version of the TDF software being executed, a scrolled list of the release 
notes associated with the build, and the software license agreement. 
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Figure 103. Version 

6 DATA EXTRACTOR 

The data extractor is a standalone application that transfers several different types of 
NIMA-standard maps from a CD to a computer (Figure 104). It supports: 

o CIB - Controlled Image Base 
o CADRG - Compressed ARC Digitized Raster Graphics 
o DTED - Digital Topographic Elevation Data 
o ADRG - ARC Digitized Raster Graphics 
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Figure 104. Data Extractor 

Starting the Data Extractor: 

1. Locate the Solipsys/Tdf/bin directory in My Computer or a similar application 
2. Right-click on extractor.bat and drag on to desktop 
3. Select Create Shortcut from menu 
4. Double-click on the extractor.bat shortcut 

Extracting a map--ADRG: 

1. Highlight a ADRG 
2. Use browse and select a new location for the maps 
3. Left-click Next 

Select tile(s) and choose an option: 

1. Compressed: Reduces file size but increases file access time. In other words, the file is 
smaller but it will take longer to load it.  

2. Transparency: It can clarify an image by transforming black pixels 
3. Left-click Next 

Use sliders to choose: 

1. Levels of Detail (1-20) - Level of detail determines the quality of teh imagery when 
display on TDF. A high level of detail takes a much longer time to extract. As scale 
decreases the level of detail decreases. 
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2. Down sample Percent – Down sampling is a form of compression. It reduces the 
resolution of an image by replacing that area with a pixel of the averaged color. It 
combines pixels to reduce file size but also decreases image quality. The higher the 
percentage the more pixels are down sampled. 

3. Left-click Next 

Select Browse: 

1. Highlight the correct directory and left-click on Open 
2. Or write in a path name: i.e. \\Solipsys\Battlelab3.3-Developer\data\geo 
3. A user must write this data into Solipsys\TDF\data\geo it will not be able to access it 
4. Left-click Extract 

While a user waits, the extractor analyzes, writes initial data, and then writes the Level of 
Detail chosen earlier. Shortly after progress meters are full, an extract button appears in the 
lower right of the panel. This indicates that the maps have been fully extracted. 

5. Finally, left-click on the Extraction Done button in the lower left 

7 NOTES 

7.1 List of Acronyms and Abbreviations 

 
ADRG Arc-Second Raster Chartmap (ARC) Digitized Raster Graphics 

ATO Air Tasking Order 

AWT Abstract Windowing Toolkit 

CANTCO Cannot Comply 

CANTPRO Cannot Process 

CADRG Compressed ARC Digitized Raster Graphics 

CCRO Close Control Read-Out 

CDF Concept Development Facility 

CDK Common Display Kernel 

CEC Cooperative Engagement Capability 

CEPN Cooperative Engagement Processor Number 

CIB Controlled Image Base 

CORBA Common Object Request Broker Architecture 

CPOD Communications Plan of the Day 

CSIL Commercial Satellite Imagery Library 
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CTRL Control Key 

CU Cooperating Unit 

CUTN Cooperating Unit Track Number 

DDS Data Distribution System 

DFAD Digital Feature Analysis Data 

DNC Digital Nautical Chart 

DTED Digital Terrain Elevation Data 

DTN Display Track Number 

DX Data Extraction or Data Extract 

EW Electronic Warfare 

FAA Federal Aviation Administration 

GUI Graphical User Interface 

HAVECO Have Complied 

HSB Hue/Saturation/Brightness 

ID Identification 

JDK Java Developer’s Kit 

JFC Java Foundation Classics 

JTN Joint Track Number 

LED Light-Emitting Diode 

MSCT Multi Source Correlator Tracker 

NIMA National Imagery and Mapping Agency 

NTDS Navy Tactical Data System 

ORB Object Request Broker 

PU Participating Unit 

PUTN Participating Unit Track Number 

RGB Red/Green/Blue 

STN System Track Number 

TACSIT Tactical Situation Awareness Area 

TDF Tactical Display Framework 

VCR Video Cassette Recorder 
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VM Virtual Machine 

WILCO Will Comply 

WVS World Vector Shoreline 
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APPENDIX A – FILTERS AND PROPERTIES

Table A. Filters 

Filter Action 
Age The time the track has been available based on the update 

time. 
Category A type of track, such as Unknown, Reference, Emergency, 

Air, Surface, Subsurface, Land, Space, Electronic Warfare. 
Commercial Any commercial aircraft in a specified region. 
CU A Cooperating Unit in the Cooperative Engagement 

Capability (CEC). 
Force Tell In the Tactical Data Links, Force Tell forces a track through 

controllable receive filters. 
Hooked Object(s) selected by the user. 

Track Identity: Identity Defined: 

Pending An evaluated track not yet identified 
although it has been through the 
identification process. 

Unknown A track not yet subjected to the 
identification process. 

Assumed Friend A Track assumed to be friendly because of 
its Characteristics, Behavior or Origin. 

Friend A Track belonging to a declared, friendly 
nation. 

Neutral A track whose Characteristics, Behavior, 
Origin, or Nationality indicates that it is 
neither supporting nor opposing friendly 
forces. 

Suspect A potentially dangerous track because of 
its Characteristics, Behavior,  
Origin or Nationality. 

Identity 

Hostile A track eligible for engagement. 
Identity/Category A combination of Track Identity and Track Category. 

IFF Mode 1 Mission   
IFF Mode 2 Military Aircraft  

Identify Friend or 
Foe (IFF) Mode 

IFF Mode 3 Commercial Aircraft  
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Filter Action 
 IFF Mode 4 Interrogation – Not 

interrogated/No Statement; 
Interrogated/No response; 
Interrogated/Invalid 
response; Interrogated/Valid 
Response 

Reporting 
Responsibility 

Tactical Data Links – The Joint Unit (JU) reporting a track 
on the data link. 

Sensor A Contributing Cooperative Engagement Capability (CEC) 
sensor. 

Source The originating source of track (CEP, Flyte, TADIL A, 
TADIL B, TADIL J, GBDL, PPDL, IBDL, ADSI, MSCS, 
TIBS, TRAP, INET, SABER, OTH, etc.) 

Sensor Unit A method to uniquely identify homogenous Air Traffic 
Control radars. 

Many track properties are also track filters. The following is a list of 
additional properties found in such applications as Track List. 

Table B. Properties 

Property Action 
CEPN Cooperative Engagement Processor Number. 
DTN Display Track Number is a unique track number assigned by the 

Server, MSCT. 
Course The equivalent of Heading. 
JTN Joint Track Number. 
SBTN Saber Beacon Track Number. 
Symbol Operators can select symbol sets via the Track Presentation.  

Typically, a symbol set defines a unique symbol for each object 
defined with a Category/ ID classification.  Some symbol sets add 
modifiers to symbols based on the state of an object, such as the 
modifiers added to emergency tracks in a Mission Control Element 
(MCE) symbol set. 
 
Other symbol sets can take advantage of amplification data 
provided over Tactical Data Links, such as Platform, Activity, and 
Specific Type. In the Mil-Std 2525A symbol set, a track identified 
as a Fighter and a F-15 Eagle has an icon representing both of these 
attributes. 
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APPENDIX B – COLOR CODING 

Table C. Color Coding 

Color Coding Action 
CU (Cooperating 
Unit) 

The operator can color code vehicles participating in the 
Cooperative Engagement Capability (CEC) Cooperating 
Units network. 

Category A type of track, such as Unknown, Reference, Emergency, 
Air, Surface, Subsurface, Land, Space, Electronic Warfare 
Track Identity: Identity Defined: 

Pending An evaluated track not yet 
identified although it has been 
through the identification 
process. 

Unknown A track not yet subjected to the 
identification process. 

Assumed Friend A Track assumed to be friendly 
because of its Characteristics, 
Behavior, or Origin. 

Friend A Track belonging to a declared, 
friendly nation. 

Neutral A track whose Characteristics, 
Behavior, Origin, or Nationality 
indicates that it is neither 
supporting nor opposing friendly 
forces. 

Suspect A potentially dangerous track 
because of its Characteristics, 
Behavior, Origin or Nationality. 

Identity 

Hostile A track eligible for engagement. 
Identity/Category A combination of Track Identity and Track Category. 

IFF Mode 1 Mission   

IFF Mode 2 Military Aircraft  
IFF Mode 3 Commercial Aircraft  

Identify Friend or 
Foe (IFF) Mode 

IFF Mode 4 Interrogation – Not interrogated/No 
Statement; Interrogated/No 
response; Interrogated/Invalid 
response; Interrogated/Valid 
Response 
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